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End User License Agreement 
This is a legal agreement between you, the end user, and Gaumard

®
 Scientific Company, Inc. 

(“Gaumard”). This software is protected by copyright laws and remains the sole property of 
Gaumard. By installing the GaumardUI (the "Software") media, you agree to be bound by the terms 
of this agreement. If you do not agree to the terms of this agreement, promptly return the 
uninstalled media and accompanying items to Gaumard at the address indicated below. 

1. Grant of License. Gaumard hereby grants to you (an individual or institution) the right to install 

and activate the Software on one computer for use with one Interactive patient simulator system. 
The software may also be installed on any number of other computers at the same institution so 
that students may access the learning resources. One copy of the software may be made for 
backup purposes. You may not network this Software, or allow multiple users unless you 
purchased a multi-user workstation license. Sharing this Software with other individuals or allowing 
other individuals to view the contents of this Software is in violation of this license. 

2. Copyright. The Software is owned by Gaumard and protected by United States copyright laws 

and international treaty provisions. Therefore, you must treat this Software like any other 
copyrighted material. You may not make this Software or copies thereof available in any manner or 
form or use, copy or transfer the Software, in whole or in part, except as provided herein. 

3. Other Restrictions. You may not rent or lease this Software to any other party. You may not alter, 

merge, modify, adapt, reverse engineer, decompile or disassemble the software, or disclose the 
contents of this Software to any other party. 

4. Electronic Transmission of Software. If you received the Software by electronic transmission or 

by Internet delivery, by installation of the Software, you acknowledge that you have read and 
understand this license agreement and agree to be bound by its terms and conditions. 

5. Term of Agreement. The term of this Agreement and the license granted to you pursuant hereto 

shall commence upon installation of this Software. This Agreement and the license granted herein 
may otherwise be terminated by Gaumard in the event that you are in breach of any provision of 
this Agreement. In the event of termination, you agree to immediately return this Software, 
accompanying items, and any copies thereof to Gaumard. 

6. LIMITED WARRANTY 

(A) THE CD-ROM MEDIA (THE "MEDIA") WHICH CONTAINS THIS SOFTWARE IS 

WARRANTED, FOR A PERIOD OF 30 DAYS FROM THE DATE OF PURCHASE, TO BE FREE 

FROM DEFECTS IN MATERIAL AND WORKMANSHIP. ELECTRONIC TRANSMISSION IS 

WARRANTED TO BE FREE FROM DEFECTS AT THE MOMENT OF TRANSMISSION. YOUR 

SOLE AND EXCLUSIVE REMEDY, AND GAUMARD'S SOLE LIABILITY, IS TO REPLACE THE 

DEFECTIVE MEDIA OR TO REPEAT THE ELECTRONIC TRANSMISSION PROVIDED THAT 

YOU NOTIFY GAUMARD IN WRITING OF SUCH DEFECT OR DEFECTIVE TRANSMISSION 

AND RETURN THE DEFECTIVE MEDIA, IF ANY, DURING THE 30-DAY WARRANTY PERIOD. 
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(B) EXCEPT AND TO THE EXTENT EXPRESSLY PROVIDED IN PARAGRAPH (A), THE 

SOFTWARE AND ACCOMPANYING WRITTEN MATERIALS ARE PROVIDED ON AN "AS IS" 

BASIS, WITHOUT ANY WARRANTIES OF ANY KIND, INCLUDING, BUT NOT LIMITED TO, ANY 

IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR 

PURPOSE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY GAUMARD, ITS 

DEALERS, DISTRIBUTORS, AGENTS OR EMPLOYEES SHALL CREATE A WARRANTY OR IN 

ANY WAY INCREASE THE SCOPE OF THIS WARRANTY, AND YOU MAY NOT RELY ON ANY 

SUCH INFORMATION OR ADVICE. GAUMARD DOES NOT WARRANT, GUARANTEE, OR 

MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF USE, OF THE 

SOFTWARE OR WRITTEN MATERIALS IN TERMS OF CORRECTNESS, ACCURACY, 

RELIABILITY, CURRENTNESS, OR OTHERWISE, AND THE ENTIRE RISK AS TO THE 

RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. IF THE 

SOFTWARE OR WRITTEN MATERIALS ARE DEFECTIVE, YOU AND NOT GAUMARD OR ITS 

DEALERS, DISTRIBUTORS, AGENTS, OR EMPLOYEES, ASSUME THE ENTIRE COST OF ALL 

NECESSARY SERVICING, REPAIR OR CORRECTION OTHER THAN EXPRESSLY 

DESCRIBED ABOVE. 

(C) NEITHER GAUMARD NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, 

PRODUCTION OR DELIVERY OF THIS PRODUCT SHALL BE LIABLE FOR ANY DIRECT, 

INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES (INCLUDING DAMAGES FOR LOSS 

OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, 

AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE SUCH PRODUCT OR 

RELATED TO THIS AGREEMENT EVEN IF GAUMARD HAS BEEN ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGES. GAUMARD SHALL NOT BE LIABLE TO YOU FOR ANY 

INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES OR LOST PROFITS 

ARISING OUT OF OR RELATED TO THIS AGREEMENT OR YOUR USE OF THE SOFTWARE 

AND/OR THE RELATED DOCUMENTATION, EVEN IF GAUMARD HAS BEEN ADVISED OF THE 

POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL GAUMARD'S LIABILITY HERE 

UNDER, IF ANY, EXCEED THE PURCHASE PRICE PAID BY YOU FOR THE SOFTWARE. 

ALL RIGHTS NOT EXPRESSLY GRANTED IN THIS LICENSE AGREEMENT ARE RESERVED 

BY GAUMARD. 

ACKNOWLEDGMENT 

BY INSTALLATION OF THIS SOFTWARE, YOU ACKNOWLEDGE THAT YOU HAVE READ AND 
UNDERSTAND THE FOREGOING AND THAT YOU AGREE TO BE BOUND BY ITS TERMS AND 
CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE COMPLETE AND 
EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND SUPERSEDES ALL 
PROPOSED OR PRIOR AGREEMENTS, ORAL OR WRITTEN, AND ANY OTHER 
COMMUNICATIONS BETWEEN THE PARTIES RELATING TO THE LICENSE DESCRIBED 
HEREIN. 
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Care and Cautions 
The Gaumard warranty does not cover 
damage caused by misuse. It is critical to 
understand and comply with the following 
guidelines to prevent injury to the user and 
damage to the simulator. 

PROCEDURES 

Do not attempt to intubate without lubricating 
the airway adjunct with silicone lubricant 
(provided). Intubating the simulator without 
lubrication may result in damage to the 
airway. 

Mouth to mouth resuscitation without a 
barrier device is not recommended, as it will 
contaminate the airway. Treat CHLOE with 
the same precautions used with a real 
patient. 

IV ARM 

Vein tubes contain latex, which may 
cause allergic reactions. Users 
allergic or sensitive to latex should 
avoid contact. Discontinue use of this 
product and seek medical attention if 
an allergic reaction occurs. 

Use only simulated blood provided by 
Gaumard. Any other simulated blood brand 
containing sugar or any additive may cause 
blockage and/or interruption of the 
vasculature system. 

The use of needles larger than 22 gauge will 
reduce the lifetime of the lower arms' skin 
and veins. 

When the arm veins require replacement, 
contact Gaumard to arrange for a lower arm 
exchange. For a small fee, we will deliver 
reconditioned and warrantied lower arm 
assemblies to your facility. Upon receiving 
the replacement arms, use the same box 
and the enclosed shipping label to return the 
old arms to Gaumard. For international and 
express service, additional fees may be 
charged. Refer to the Consumables and 
Replacement Parts section of this guide, and 
contact customer service for more 
information. 

STORAGE 

Store CHLOE in a cool, dry place; extended 
storage above 85 degrees Fahrenheit (29 
Celsius) will cause the simulator to soften 
and slowly warp. It is acceptable to operate 
CHLOE at an ambient temperature of 95 
degrees Fahrenheit (35 Celsius). 

Do not store the simulator with a discharged 
battery. Re-charge the backup battery at the 
end of every simulation session. In addition, 
recharge the battery at least once every 30 
days even if the simulator is not in use; 
otherwise, permanent loss of capacity might 
occur because of self-discharge.  

CLEANING 

Clean CHLOE with a cloth dampened with 
diluted liquid dishwashing soap. If medical 
adhesives remain on the skin, clean with 
alcohol wipes.  

Do not use citric acid cleaners anywhere on 
the simulator. Doing so will cause pitting of 
the various materials comprising your 
simulator. 

CHLOE is "splash-proof" but not waterproof. 
Do not submerge or allow water to enter the 
interior of the simulator. Do not expose the 
tablet computer to water or excessive dust. 

Always purge and drain the arterial and 
vein reservoirs at the end of the 
simulation session. Doing so will prevent 
molding or clogging. 

SURGICAL 

Use only simulated blood provided by 
Gaumard. Any other simulated blood brand 
containing sugar or any additive may cause 
blockage and/or interruption of the 
vasculature system. 

Always clean and purge the reservoirs at 
the end of simulation. Do not store the 
simulator with fluid in the reservoirs or 
the internal arterial and venous 
vasculatures. For more information, go to 
page 127. 

Do not allow simulated blood to puddle 
beneath the simulator or to reach the lower 
back. 

Do not allow simulated blood to puddle 
inside the abdominal cavity. 

Remove the uterine assembly and clean 
thoroughly using diluted soap and water to 
prevent staining or molding. 
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Always lubricate the surgical tools prior to 
insertion. Doing so will prevent damage to 
the laparoscopy ports. 

ASSEMBLIES 

Do not use electrosurgical or cauterization 
tools on any of the uterine assemblies or 
abdominal covers. 

Always handle the assemblies with clean 
hands. 

Clean the assemblies with diluted soap and 
water. Do not clean with alcohol or 
aggressive solvents. 

Do not pack any sharp objects with the 
assemblies. 

Prevent items from resting or pressing 
against the assemblies as indentations will 
form on the pressure points.  

Apply talcum powder to the assemblies to 
reduce tackiness. 

CLEANING THE 
ELECTROCARDIOGRAM SITES 

Always keep the electrocardiogram sites 
clean. 

Always clean the conductive sites at the end 
of simulation using a gentle degreasing 
cleanser or soap and water. 

Do not leave ECG electrodes attached for 
use the next day. 

Never attempt to service or modify any of the 
electrocardiogram sites. Discontinue use if 
any wires are exposed with damaged 
insulation. 

If dark traces appear on the 
electrocardiogram sites, use a pencil eraser 
to remove the traces and then clean with 
alcohol or soap and water.  

Do not scratch the conductive patches with 
abrasive objects; doing so will cause 
irreversible damage to the conductive sites. 

Specifications 
Height: 5 feet, 9 inches (175 cm) 

Weight: 65 lbs. (29 kg) 

Power input: 100-240 VAC, 

50/60 Hz, 2 A 

Power output: 13 VDC, 9.2 A 

Capacity of hemorrhage reservoirs: 

Arterial: 750 ml 

Venous: 750 ml 

Simulator connectivity:  
Wired (RJ45) Gaumard USB communication 
module 

Environmental 

Operating temperature: 45F to 95F (7C to 

35C) 

Storage:  55F to 85F (13C to 29C) 

 

The SURGICAL CHLOE simulation system 
is protected by US patents; other Patents 
Pending.  

Gaumard®, CHLOE ®, HAL
®
 are trademarks 

of Gaumard Scientific Company, Inc. 

© Gaumard Scientific Company, 2013. Made 
in U.S.A. All rights reserved.
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Getting Started 
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Terminology 
Facilitator - the person conducting the 
simulation; an instructor or lab staff member. 

GUI - the Gaumard User Interface - is the 
software application, used to control the 
simulator and evaluate care providers. 

Palette - a collection of Palette Items. Each 
profile has its own palette. 

Palette Item - Any full or partial set of 
physiological parameters that have been 
grouped and saved together under a single 
name. 

Profile - a unique CHLOE software 
configuration, including custom Palette, 
Scenarios, and options. Each Profile acts as 
a separate program, in that changes made to 
one profile have no effect on the others. 

Provider - a person participating in the 
simulation as a healthcare provider. 

Scenario - a saved sequence of 
physiological states, like a "playlist." 
Scenarios provide a level of automation that 
unburdens the facilitator and allows 
standardized presentation of symptoms. 

Scenario Item - a Palette Item that is part of 
a scenario. Scenario Items may also 
represent a fixed delay period ("Wait") or a 
pause ("Wait Indefinitely"). 

Stylus - a special pointing device for the 
tablet computer. The stylus is the fastest and 
easiest means of controlling the CHLOE 
software. See the Equipment Set-up section 
of this guide for more information on working 
with the stylus. 
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Overview 
Surgical Chloe can be used to address 
competencies in six areas including: patient 
care, medical knowledge, practice based 
knowledge and improvement, systems 
based practice, communication, and 
professionalism. 

GENERAL 

 Powered from an internal rechargeable 
battery or wall outlet 

 Simulator receives commands from a 
wired Laptop (15 foot Ethernet cable 
included) 

 Use preprogrammed scenarios, modify 
them or create your own quickly and 
easily 

 Remains fully functional even while in 
transit 

 Workbook of ten (10) advanced 
scenarios and example surgical 
checklists 

 Training Video 

SURGICAL COMPONENTS 

Uterine Assembly 1: Normal Uterus with 

ectopic pregnancy and uterine bleeding. 

Simulates ruptured Ectopic pregnancy with 
bleeding, severe vaginal bleeding from 
uterus, and includes bladder. 

Uterine Assembly 2: Enlarged Uterus with 

dermoid cyst on one side and ectopic 
pregnancy on the other. Simulates ruptured 
ectopic pregnancy with bleeding; also 
includes realistic dermoid and bladder. 

Uterine Assembly 3: Enlarged uterus with 

embedded fibroids, endometrioma on one 
side, and simple cyst on the other. Simulates 
embedded bleeding fibroids; also includes 
realistic simple cyst, endometrioma, and 
bladder. 

ABDOMINAL WALL INSERT 

 Use your instruments for incision, 
dissection, and suturing  

 Can be used at least four (4) times  

 Multi-layer design replicates the skin, 
subcutaneous, fascia, muscle, and 
peritoneum  

 Incorporates bleeding  

 Can be used to perform either 
Pfannenstiel or vertical incision  

 Can be used to place laparoscopic 
trocars 

LAPAROSCOPY ABDOMINAL 
WALL 

 Includes 8 access ports on left, right, 
and midline of abdominal wall 

BOWEL OVERLAY 

 Includes insert that can be placed over 
uterine assembly for added realism 

PREPROGRAMMED SCENARIOS 
BY MARTIN E. OLSEN, MD 

 Ruptured ectopic pregnancy 

 Pelvic mass in pregnancy 

 Septic abortion 

 Bleeding disorder Von Willebrand’s 
disease 

 Post-operative hemorrhage after 
conization of the cervix 

 Fire in the OR 

 Malignant hyperthermia during surgery 

 Cardiac arrest in the OR 

 Anaphylaxis and Hypoxia in the OR 

AIRWAY 

 Multiple upper airway sounds 
synchronized with breathing 

 Bag-Valve-Mask Ventilation 

 Placement of conventional airway 
adjuncts 

BREATHING 

 Control rate and depth of respiration 

 Chest rise and lung sounds are 
synchronized with selectable breathing 
patterns 

 Simulated spontaneous breathing 

 Normal and abnormal breath sounds 
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CARDIAC 

 Conductive skin regions allow for ECG 
monitoring with real equipment 

 Heart sounds may be auscultated and 
are synchronized with ECG 

CIRCULATION 

 Measure blood pressure by palpation or 
auscultation  

 Use real BP cuff rather than a “virtual” 
cuff to measure blood pressure  

 Korotkoff sounds audible between 
systolic and diastolic pressures  

 Oxygen saturation detected using real 
monitors rather than a “virtual” value  

 Pulse sites synchronized with BP and 
heart rate  

 Bilateral IV arms with fill/drain sites Sub-
Q and IM injection sites 

 ECG monitoring using real devices  

 Multiple heart sounds, rates and 
intensities 

 Virtual ECG rhythms are generated in 
real time  

 Ovarian and Uterine arteries and veins, 
with bleeding functionality  

 During application of scenarios, vital 
signs reflect physiologic changes that 
occur with hemorrhage 

NEURAL RESPONSES 

 Open and close the eyes manually 

SPEECH 

 Wireless streaming audio & prerecorded 
responses 

 Create and store vocal responses in any 
language 

USER INTERFACE 

 Sensors track participants actions 

 Changes in condition and care provided 
are time stamped and logged 

 Create your own scenarios - add/edit 

 Change simulator’s condition during the 
scenario 

20” ALL-IN-ONE TOUCH SCREEN 
PC TO DISPLAY VITAL SIGNS 

 Display the simulator vital signs in real 
time 

 Use preprogramed layouts or create 
your own configuration to mimic the real 
patient monitors used in your facility 

 Share images such as ultrasounds, CT 
scans, lab results 

 Touchscreen control 

PRO+ RECORDING AND 
DEBRIEFING SYSTEM 

 Record and synchronize video with the 
simulation event information for 
debriefing 

 Two (2) built in infrared cameras in 
lower torso to record surgical technique 
from the inside 

 One (1) head mounted camera 

 One (1) overhead camera records 
actions of the surgical team 

INCLUDES 

 One GaumardUI control PC 

 Pro+ Recording and debriefing system 
(S2100) 

 Vital Signs Monitor 

 Four (4) abdominal wall inserts 

 Twelve (12) uterine assemblies, four (4) 
of each type 

 CD-ROM demonstration video  

 Soft sided case with rollers 

 Surgical Chloe Workbook by Martin E. 
Olsen, MD 

 User Guide 
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Equipment Setup 
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Surgical Chloe 
Setup 

LEG ASSEMBLY 

To install the lower legs: 

 Remove the fixed bolts from the knee 1.
joints using the hexagonal wrench 
included. 

 

 Position the lower legs and re-insert the 2.
knee joint bolt. Then, secure the knee 
bolts without over tightening.  

 

POWER SUPPLY 

Connect the power adapter labeled “Surgical 
Chloe” to the power input port located on 
Surgical Chloe’s right side.  

 

Chloe is equipped with an internal backup 
battery. During simulation, the power adapter 
can be briefly disconnected to transport 
Chloe from one room to another. 

Always operate CHLOE while 
connected to the power supply. 

The backup battery level is displayed on the 
GaumardUI status panel. For more 
information about the backup battery 
indicator, go to page 26. 

Do not store the simulator with a 
discharged battery. Re-charge the 
system at least once every 30 days 
when not in use. Otherwise, 
permanent loss of capacity might 
occur. 

PRO+ PC  
(Chloe S2100) 
The PRO+ system allows the facilitator to 
control the simulator’s vital signs, monitor 
and record the simulation session, and 
debrief, all from one PC. The PRO+ system 
is the standard control PC included with the 
Surgical Chloe S2100 package. 

 

The Surgical Chloe S2100 PRO+ package 
includes: 

 Convertible PRO+ PC 

 USB communication module 

 Ethernet cable (RJ45) 

 Streaming audio headset 

 Wireless overhead camera 

 Surgeon’s view head mounted camera 

 Two infrared pelvic cameras 
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USB COMMUNICATION MODULE 

The USB communication module relays the 
startup and control commands from the 
PRO+ PC to the simulator via an “RJ45” 
cable (included). 

Do not connect the simulator to 
Ethernet cards, LAN networks, or 
unauthorized diagnostic equipment. 
Doing so may cause damage to the 
system. 

To connect the simulator to the PRO+ PC: 

 Connect the RJ45 cable to the USB 1.
communication module. 

 

 Connect the USB communication 2.
module to an available USB port on the 
PRO+ laptop. 

 

 Connect the RJ45 cable to the 3.
simulator’s RJ45 port. 

 

Please review the documentation 
included with the product for 
important care and warning 
information. 

Complete the camera setup before 
turning on the PRO+ PC. 

STREAMING AUDIO HEADSET 

The PRO+ system includes a headset that 
allows the facilitator to speak as Chloe’s 
voice and listen to the participants reply. 

Connect the headset MIC and Speaker 
connectors to the designated ports on the 
left side of the tablet PC. 

 

PRO+ CAMERAS 

The PRO + cameras allow the facilitator to 
monitor and record footage of the simulation 
from various angles. The video feed is 
synchronized with the event log information 
generated by the GaumardUI software and 
stored in the PRO+ PC for debriefing. 

ABDOMINAL CAMERAS 

There are two infrared cameras located 
inside Chloe’s abdomen to monitor surgical 
procedures.  
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Connect the two USB cables located on 
Chloe’s right side to the USB ports located 
on the rear of the PRO+ PC. 

 

WIRELESS OVERHEAD CAMERA 

The wireless overhead camera records a 
general view of the operating table. 

To setup the wireless camera, first connect 
the camera to the power supply and then 
place the camera high above the operating 
table.  

 

The wireless camera will automatically 
establish a connection when the PRO+ PC is 
powered on. 

SURGEON’S VIEW CAMERA 

The surgeon head camera provides a first 
person view of the operative field.  

 

The head cam system includes a hands-free 
transmitter that sends the video feed to the 
PRO+ computer wirelessly. 

To setup the head camera: 

 Connect the USB camera adapter to the 1.
transmitter  

 

 Connect the camera to the USB adapter 2.

 

 Power on the transmitter 3.

 

 Launch the PRO+ head camera 4.
application 

 

The head camera will automatically establish 
a connection when the PRO+ PC is powered 
on. 
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Control Tablet PC 
(Chloe S2101) 
The tablet PC is preloaded with the 
GaumardUI control software used by the 
facilitator to initialize the simulator and 
control the vital signs. The PRO+ system is 
the standard control PC included with the 
Surgical Chloe S2101 package. 

The Surgical Chloe S2101 package includes: 

 Tablet PC 

 Streaming audio headset 

Before turning on the computer for the 
first time, please review the 
documentation included with the 
product for important care and 
warning information. 

USING THE STYLUS 

The tablet’s stylus is a pen-shaped input 
used to interact with files and programs.  

 Left click - tap the screen with the 
pointer. Tap twice rapidly to double-
click. 

 Right click- tap and hold a highlighted 
item or hold the button near the pointer 
and tap the item or text. 

CALIBRATING THE STYLUS 

As part of the initial setup, calibrate the 
stylus using the Tablet and Pen calibration 
tool in the Windows

®
 control panel. For 

greater accuracy, complete the calibration 
process while holding the pen in a natural 
writing position. 

USB COMMUNICATION MODULE 

The USB communication module relays the 
startup and control commands from the 
control tablet to the simulator via a “RJ45” 
cable (included).  

Do not connect the simulator to 
Ethernet cards, LAN networks, or 
unauthorized diagnostic equipment. 
Doing so may cause damage to the 
system. 

To connect the simulator to the Tablet PC: 

 Connect the RJ45 cable to the USB 1.
communication module. 

 

 Connect the RJ45 cable to the 2.
communication port on the simulator’s 
right side. 

 

 Connect the communication module to 3.
an available USB port on the tablet PC. 

 

The tablet is now ready to communicate with 
simulator. 
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STREAMING AUDIO HEADSET 

The computer system includes a headset 
that allows the facilitator to speak as Chloe’s 
voice and listen to the participants reply. 

Connect the headset MIC and Speaker 
connectors to the designated ports on the 
left side of the tablet PC. 

 

Always connect the streaming audio 
headset before starting the 
GaumardUI software. 

Virtual Monitor 
The Gaumard Monitors software displays 
Chloe’s simulated vital signs in real time. 
The interactive monitoring software is 
preloaded in to the virtual monitors PC.  

The virtual monitor PC also allows the 
facilitator to play back the session recordings 
stored in the PRO+ PC for debriefing. 

 

 

VIRTUAL MONITOR PC SETUP 

Refer to the manufacturer’s documentation 
included with the virtual monitor system 
components for important safety, installation, 
and start-up information before turning on 
the computer for the first time. 

To setup the virtual monitor PC: 

 Place the all-in-one PC within line of 1.
sight of the controlling computer 

 Connect the power supply 2.

 Connect the USB keyboard and mouse 3.
receiver 

 Turn on the computer 4.

VIRTUAL MONITOR WIRELESS 
CONNECTIVITY 

The control PC and the all-in-one virtual 
monitor PC automatically establish a 
wireless link at startup. The wireless 
connection allows the Gaumard control 
software to transmit the vital signs 
information to the Gaumard Monitors 
software.  

To verify the wireless link between the two 
computers, click the wireless icon located on 
the task tray. The wireless network name is 
randomly generated at the factory and may 
differ from the one seen below. To 
troubleshoot connection issues, please go to 
page 147. 
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GAUMARD MONITORS 

After the wireless connection is established, 
double click or tap the Gaumard Monitors 
icon to start the vital signs software.  

 

The Gaumard Monitors software is now 
ready to receive the vital signs information 
generated by the GaumardUI control 
software. 

 

For more information about the Gaumard 
Monitors software, please refer to the 
Gaumard Monitors user guide. 
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Working with 
GaumardUI
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Initializing Chloe 
(PRO+ S2100) 
After reading the PC manufacturer’s care 
and caution information, slide the power 
button to turn on the PRO+ computer: 

 

To log in to the PRO+ system: 

 Power on the PRO+ computer  1.

 Enter “admin” for both, the user name 2.
and password fields at the login screen  

 

Default Login Credentials 

User Name admin 

Password admin 

 Click “SUBMIT” to continue 3.

Following a brief loading screen, the 
GaumardUI start screen is shown.  

 Click “START” to initialize the simulator. 4.

 

The GaumardUI software initializes the 
simulator. When the Gaumard software is 
closed, the simulator enters stand-by mode.  

The wired link between GaumardUI and the 
simulator is established within approximately 
1 minute. 

 

The PRO+ system starts to record 
video automatically when the 
GaumardUI software is initialized. For 
more information about the recording 
functionality, go to page 133. 

Initializing Chloe 
(Tablet PC S2101) 
After reading the manufacturer’s care and 
caution information, press the power button 
to turn on the Tablet PC. 

 

The GaumardUI software initializes the 
simulator. Double click the GaumardUI icon 
on the tablet’s home screen to start.  
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The simulator selection menu is shown. 
Select Surgical Chloe and click “Start”. 

 

The wired link between GaumardUI and the 
simulator is established within approximately 
1 minute. 

 

Profiles and 
Operating Modes 
After the startup screen, the profile and 
operating mode selection menu is displayed.  

 

The GaumardUI control software has two 
modes of operation: Manual and Automatic. 
Each mode includes a Quick Start profile 
with preprogrammed scenarios exercises 
created in conjunction with experienced 
healthcare instructors and working medical 
professionals. Continue to the next section to 
learn more about the each operating mode 
and the profiles included.  

After selecting an operating mode and 
profile, click “Load” to continue. 

Manual Mode   

In the “Manual” operating mode, the 
facilitator fully controls the vital signs and 
physiologic responses.  

 

The profiles available under Manual Mode 
are the following: 

Default Profile – includes one 

preprogrammed palette with healthy vital 
signs.  

Quick Start Chloe – contains eleven 

preprogrammed scenarios and one linear 
scenario.   

Automatic Mode 

In the automatic mode, the GaumardUI’s 
physiologic model assists the facilitator by 
automatically changing vital signs in 
response to caregiver participation, 
pharmacologic intervention, and manual 
input.  

The physiologic model calculates responses 
based on physiologic principles. For 
example, when facilitator increases the heart 
rate, the physiologic model will calculate the 
response and automatically adjust the blood 
pressure. To activate this operating mode as 
an upgrade option, go to page 101. For more 
information on this mode and its features, go 
to page 31. 

 

The profiles available for the Automatic 
operating mode are: 
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Default Modeling – includes one 

preprogrammed palette with healthy vital 
signs. 

Meds Profile – contains a library of pre-

programmed medications. 

Quick Start Chloe Modeling – contains 

eleven preprogrammed scenarios and one 
linear scenario.   

For more information on each of the scenario 
exercises included with the Quick Start 
profile, go to page 56. 

CREATING A NEW PROFILE  

Profiles store palette, scenario, and option 
settings independently; changes made to 
one profile have no effect on the others. 
Below are some examples on how profiles 
are used. 

 Assign one profile to each user of your 
Gaumard simulator system 

 Use profiles to organize and protect 
palettes and scenarios 

 Create a profile dedicated to a specific 
academic course taught by multiple 
instructors 

 Devote an entire profile to one particular 
subject area, or even one particular 
scenario 

To create a new profile, click “New Profile”. 

 

Enter a name for the new profile followed by 
a description. 

To include scenarios and palettes from other 
profiles, click the check box. For security, 
enable PIN protection and enter a four-digit 
key  

Finally, click “Create” to save the new profile. 
To import and export profiles, navigate to 
page. 

. 

 



24 | Surgical Chloe | User Guide

Environment 

THE STATUS PANEL 

The Status panel is visible along the left edge of the GUI window at all times. After the connection 
to the simulator is established, the status panel displays current information about the battery level, 
signal strength, volume controls/levels, and vital signs in real time. 

MANUAL MODE AUTOMATIC MODE 

 

Click the arrow to expand the status 
viewer. 
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Light blue icons display active features. Values undergoing changes are highlighted in yellow. Click 
on the volume bars located on the right to adjust the volume of each sound. 

 

Volume 

Control 

Backup 

Battery Level  

Active 

feature 

Inactive 

feature 

Simulator 

Connectivity  
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COMMUNICATION INDICATOR 

Use the signal icon to monitor the hard-wired connection between the laptop and the simulator. The 
indicator is clear when no attempts to communicate with the simulator are being made; for example 
when the module is not connected to the computer or the system is in STAND-BY mode. Full bars 
indicate excellent communication between the computer and the simulator (i.e., normal operation). 

 

BACKUP BATTERY INDICATOR 

The battery charge level is displayed in real time when the connection is established with the 
simulator. The exclamation mark is displayed when there is no communication with the simulator.  

When the battery indicator blinks red (low battery), the simulator is set to STAND-BY mode 
automatically. Reconnect the simulator to the power adapter to turn the simulator back on. 

 

Always operate the simulator connected to power adapter. The internal battery provides 
temporary power only when transporting the simulator between rooms. 

SIMULATOR VOLUMES 

Adjust the volume of each sound using the Status Panel volume control. Click on the volume level 
indicator next to each sound to raise or lower the volume of the feature. Volume changes are 
applied immediately and do not need to be submitted using the apply panel.  

  

STAND-BY 

The standby button is located on the bottom right corner of the GaumardUI software. Use the 
stand-by feature to conserve the backup battery during transport.  
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Details 
The individual parameter controls displayed on the details tab are the simplest form of controlling 
the simulator. To update the simulator’s condition, change the value of the vital sign control and 
submit the change using the “Apply” menu. Changes are applied immediately by clicking the 
“NOW” button. 

Please note that vital signs parameters not specified or left blank will remain unchanged. 

Vital sign parameter controls are divided into several categories. Each vital sign control entry has a 
corresponding entry on the status panel providing real time information on the status. 

The Details tab is also used to create Palette items. A single palette item stores the settings of 
several vital sign parameters controls. For more information about creating and saving palette 
items, go to page 30.  

 

Vital sign parameter controls shown on the Details tab are dependent on the simulator’s 
features and configuration. GaumardUI displays applicable controls automatically once 
the connection is established. 
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CHANGING VITALS 

Click or tap the slider control to adjust numerical values using the stylus. Alternatively, use the 
keyboard to enter values manually.  

No changes will be made to the simulator’s condition until the new settings are 
submitted using the “Apply” panel. 

 

Click on the down arrow to access different sound types and rhythms. 

 

Click the feature control button to enable (blue) or disable (black) arterial and venous circulation 
into the uterine assembly. Alternatively, click the icon clear to make no change to the status. Some 
feature controls may not be available depending on the simulator configuration. No changes will be 
made to the simulator’s condition until the new settings are submitted using the “Apply” panel. 

 

 

For information on the feature controls specific to the simulator’s features, go to the “Working with 
CHLOE” section of this guide. 
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APPLY PANEL 

After the vital signs are set, click any of the “Apply” buttons located near the bottom of the page to 
update the simulator’s condition. Click NOW to update the simulator’s condition instantly. 

Alternatively, click a trending timer to update numerical vital sign parameters (e.g. heart rate, blood 
pressure) gradually in the time allotted. Click the edit button to customize a transition time. 

Please note that vital signs parameters not specified or left blank will remain unchanged. 

 

Vital sign parameter states such as cardiac rhythm and breathing pattern update immediately. 
Numerical parameters, however, such as heart rate and respiratory rate can be trended.  

As transitions are applied, the time remaining in the transition is displayed on the Clocks panel at 

the bottom of the GaumardUI window. If there is already an ongoing transition at the moment you 
click an Apply button, it will stop and a new transition will begin from the current physiological state. 

 

When cardiac rhythm is maintained at Ventricular Tachycardia for one minute, the following prompt 
dialog box will be displayed.  

 

Click “Yes” to degrade the cardiac rhythm to ventricular fibrillation. Click “No” to maintain the 
cardiac rhythm and recheck after 1 more minute. Click “Cancel” to stop the software from checking 
the cardiac rhythm every minute. 

To apply electrical therapy virtually, click the “Shock Panel” shortcut near the top of the screen. If 
the Shock Panel shortcut is not shown on the menu bar, click Setup>Options>General and check 
mark “Show defibrillation/cardioversion/pacer panel”. 
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PALETTE ITEMS 

The Details tab is also used to create Palette Items. A single palette item stores the settings of 
several vital sign parameters controls in a single loadable object. Use a palette item to quickly 
update a set of vital signs parameters at the same time. For example, a percentage drop in all 
cardiovascular related vital signs. A large library of pre-programmed palette items is included in the 
Quick Start Profile. 

 

Palette items are also used to build scenarios. In the Scenario tab, palette items are queued in a 
list and played back in succession to automate the changes in the simulator’s condition during a 
training exercise. For more information about scenario building, go to page 38 . 

CREATING PALETTE ITEMS 

To create a Palette Item, choose the desired parameters on the Details page and click the “Save as 
Palette Item” button near the top of the page.  

 

Enter a name for the palette, specify a description, and color code. Click “Save” to create the new 
palette Item. Palette items are stored in the active profile.  
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AUTOMATIC MODE 

In the automatic mode, GaumardUI adjusts the patient’s vital signs automatically in response to 
caregiver participation, instructor input, and pharmacologic intervention. For example, if the heart 
rate is increased, the physiologic model will calculate a realistic response to the event and adjust 
the blood pressure values automatically. 

If the automatic mode option is not available on the Profiles menu, click “Setup>Options>Other” 
and enter the code included the feature in the Model Activation Code field. To switch between 

operating modes without restarting the software, click File>Profile. 

PHYSIOLOGIC MODEL 

The physiologic model is the software engine that calculates responses based on physiologic 
principles. Click the “Pause” button located on the right panel to freeze the model calculations 
during lectures, and then again to resume. To return the patient to the initial state, click “Reset”. 

 

PATIENT PROFILE 

Patient files store general information such as weight, height, and age. The physiologic model 
factors in the patient’s weight as it adjust related physiological parameters. GaumardUI includes 
several preprogrammed patients in the Quick Start Modeling profile. For more information on the 
each patient profile, go to page 104. 

Chloe is the default patient loaded when the Quick Start Modeling Profile is selected and it is an 
ideal candidate for most simulations. Information about the patient is shown on the right panel. For 
information on creating new patient profiles, go to page 102. 

AUTOMATIC MODE CONTROLS 

In the automatic mode, the Details tab includes additional vital sign parameters and control options. 
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To navigate between the vital sign parameter categories, click the vertical tabs. The tabs divide 
controls related to airway, breathing, and circulation among others. 

 

The HOLD and Auto buttons are unique to the automatic mode. Similar to manual mode, click an 
apply button to submit changes. Some changes are gradual even when the NOW apply button is 

pressed. The delay results from using a closed loop model that adjusts other related values over 
time, rather than displaying a unique value that is unrelated to other parameters. 

HOLD: Allows you to keep a current value constant. Recall, that in the manual mode, to keep a 
value constant, simply leave the control blank. Click on the H to change the option from Auto to 
HOLD. 

 

Auto: Allow the model to auto-adjust the value. Click the input field blank to return to the default 

auto state. 

 

Manual: Input the value of the parameter manually. The model automatically adjusts related 

physiological values. 
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AIRWAY/APPEARANCE/BREATHING TAB 

The A-B vertical details tab includes the airway, appearance, and breathing controls. 

Change the oxygen saturation by adjusting one of the following four parameters. Click on the “?” 
button to view a brief description of the four options. 

Options 2-4 take from 30 seconds to 3 minutes to change. Lower OSat settings will decrease the 
model’s stability and put patient into crisis. 

 

 Total O2 level: oxygen reserve in the body. 

 Shunt flow: the percentage of deoxygenated blood in 
pulmonary capillaries. 

 Respiratory pattern Airway construction 

 Airway obstruction 

ETCO2 

Similarly, EtCO2 can be changed by adjusting one of four parameters: 

 

 

 Total CO2 level: CO2 
build-up in the body; 

 Dead Space: part of tidal 
volume that doesn’t 
participate in gas 
exchange. 

 Respiratory Pattern 

 Ph level 
 

LUNG CONDITION 

Change the condition and the model will automatically adjust the shunt flow, dead space, airway 
resistance, and respiratory pattern. 
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TIDAL VOLUME 

Adjust the tidal volume or amount of air breathed in or out during normal respiration. In the model, a 
tidal volume of 500 m/L is considered the normal level for an adult of average build. 

If the respiratory rate goes to zero, the model does not restore it automatically. Always 
remember to specify a new respiratory rate. 

 

CIRCULATION AND OTHER TAB 

The C/O vertical details tab includes the circulation and breathing controls.  

 

Each cardiac rhythm has a specific effect on the blood pressure waveforms. The pressure wave 
forms include ABP, CVP, PAWP and Pulse. 

Mild cyanosis is activated when the oxygen saturation is less than 92% and/or the temperature is 
less than 35° C. Values under these thresholds will cause the cyanosis to get progressively worse. 

Similar to O2Sat and EtCO2, blood pressure can be changed indirectly when using the modeling 
mode. You can do so by selecting one of four options.  

 Vascular profiles: vessel diameter and vessel stiffness. 

 Heart Rate 

 LV Contractility 

 Total Blood Volume 
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PATIENT STATUS  

Set the patient status to “Excited” (after exercise) to increases heart rate, temperature, respiratory 
rate, tidal volume, O2, CO2 diffusion capacity, metabolic rate, and CO2 formation rate. Set the 
status to “resting” for a normal state. 

 

BLEED AND WOUND SIZE 

The Bleed and Wound size options simulate blood loss within the patient model. To start the virtual 
bleeding click the “Bleed” button and adjust the bleeding rate using the “Wound Size” control.  

 

Once activated the physiologic model adjusts the simulator’s vital signs in response to the blood 
loss rate gradually. Without intervention, the vital signs will deteriorate until eventually, myocardial 
ischemia occurs. For information on how to infuse blood to the model virtually, go to page 72. 

 

Enable simulator’s bleeding system and the model virtual bleeding rate to automate the 
physiological responses to blood loss during a surgical procedure. To fill the simulator’s bleeding 
system with fluid and enable bleeding, go to page 119. 

ADVANCED TAB 

The Adv vertical tab includes advanced cardiac, circulatory, respiratory and environment controls. 
All the controls in this page are unique to the automatic mode. 

The advanced tab gives you more control over the model by allowing you to edit additional 
parameters that have an effect on the cardiovascular and respiratory systems. Use this page if you 
want to add complexity to a scenario or if you need to superimpose special conditions. 

Cardiac irritability can be used to modify cardiac rhythms indirectly. You can improve (move 
towards normal sinus rhythm), or deteriorate (move towards ventricular fibrillation and asystole) any 
of the rhythms. 
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The progression of rhythms generally follows the pattern displayed in the figure below, where “X” 
represents normal sinus rhythm, multifocal atrial tachycardia, atrial flutter, atrial fibrillation, 
junctional rhythm, left or right bundle branch block, or atrio-ventricular block:  
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Palettes 
Use the Palette tab to sort, manage, and edit the palette items in the current profile. Each profile 
stores an independent library of palette items. 

To modify the vital sign parameters programmed into a palette select a palette and click the Edit 
button. After the changes are made using the Details tab click the “Save as Palette” Item button., 
See the Tips on Palette Item and Scenario Creation section of the appendix for more information 
on customizing palettes. 

To apply a palette and change the simulator’s condition select the palette item and click one of the 
“Apply” menu options.  
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Scenarios 

LINEAR SCENARIOS 

GaumardUI includes several preprogrammed scenarios to simulate a variety of complications. All 
preprogrammed scenarios are included in the “Quick Start Profile”. To switch between profiles 
without exiting the software click FILE> Profile. For this example select and load the “Quick Start 
Profile”. 

To use a preprogrammed scenario go to the Scenario tab and click “Load Scenario”. 

 

The Load Scenario dialog box appears. Select a scenario and click on Load. For a list of all the 
scenarios available, go to page 56. 

LINEAR SCENARIOS OVERVIEW 

Linear scenarios are composed of vital signs palette items and wait palette items played in 
succession.  

 

During the scenario each vital signs palette updates the patient’s condition. As outlined previously, 
palette items are created using the Details tab. 

The transition time trends over seconds or minutes the increase or decrease of numerical vital 
signs such as blood pressure.  

Wait palettes do not update or change vital signs. Instead, wait palettes give the provider time to 
perform an action; this may be treatment in response to a complication or performing a standard 
assessment.  

Vital sign 

Palette items 

Wait palette 

items 
Progress 

indicator 
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SCENARIO CONTROLS 

Scenarios are controlled using the buttons at the bottom of the tab. Intuitively, the facilitator can 
play, stop, pause, skip, or repeat items as necessary.   

 

SCENARIO POSITION INDICATOR 

 

A blank triangle means that the scenario is stopped at the item indicated. Click the 
play button to start or continue the scenario.. 

 

A rapidly blinking triangle means that the scenario is playing the item indicated. 

 

A slowly blinking triangle means that the scenario is paused at the item indicated. 

SCENARIO PLAYER CONTROLS 

 

Start the scenario or play the item selected. 

 

Click the pause button to halt the scenario and to resume. 

 

Click the “stop” button once to end the scenario when the current transition 
expires. Alternatively, click stop a second time to end the scenario immediately.  

 

The “next” button advances the progress indicator to the next item on the 
scenario. Click next to proceed to the next palette from a “wait indefinitely” 
palette. 

 

The “Previous” button returns the indicator to the previous item in the scenario. 

 

The Reset button stops the scenario immediately and returns the indicator to 
the first item in the scenario. 

Reset 

Pause/

Play 

Next 

palette 

Previous 

palette 
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SCENARIO QUICK LAUNCH 

Use the scenario Quick Launch tab to start a scenario with a single click. The Quick Launch tab 
displays all the scenarios saved in the current profile. 

 

CREATING A NEW LINEAR SCENARIO 

Build new scenarios to expand the number of exercises available in a training program. The 
general process of creating a new linear scenario is the following: 

 Create a vital sign palette item for each state in the scenario 

 Add the vital signs palettes and wait times to the scenario 

 Play the scenario 

 Modify and edit palettes 

 Save the scenario 

CREATING PALETTE ITEMS 

The first step is to create several vital sign palette items using the Details tab. Each palette item 
represents a physiological state during the scenario. 

Program the first palette item to be used as the scenario’s starting point. Set values for all the 
physiological parameters, sound types, and volumes. This ensures that when the scenario begins 
no vital signs from a previous state will inadvertently carry on to the scenario exercise.  

On the Details tab, enter the vital signs for the starting physiological state in the scenario and click 
the “Save as Palette Item” button. 
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The “Save as Palette Item” dialog box is displayed. Type in the palette item name and a brief 
description; assign a color tag and click “Save”. 

 

After the first palette is saved, create the next palette item with only those vital sign parameters that 
are relevant to the second stage in the patient’s condition. Repeat this process to create palettes 
for the third and final stage in the scenario. Remember to program only the values that require 
change. 

After all the vital sign palettes are created, go to the “Scenario” tab and click “Add to Scenario”. 
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The Add Palette item menu is shown. From the list, select the vital sign palette previously 
programmed to be first state in the scenario. Enter 0min 0sec for the transition time so the initial 
vital signs are applied immediately. Click “Add” to add the palette to the scenario. 

 

The first palette is now added. Click “Add Palette to Scenario” button again to add more vital sign 
palettes and wait palette items. 
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A “Wait” item maintains vital signs values steady for the transition time allotted. Insert a “wait” item 
after a vital signs palette to give the provider time to perform an action or an assessment. For 
example, auscultating blood pressure or gathering general information about the patient. After the 
transition time expires, the scenario will automatically move on to the next item. Alternatively, add 
“Wait Indefinitely” to hold the vital signs until the facilitator manually advances the scenario to the 
next item using the scenario controls. 

 

After the palettes are loaded, use the “Selected Item” menu to edit the scenario items.  
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After the scenario is completed, click “Save Scenario” to store the scenario in the current profile for 
later use. 

 

ADDITIONAL SCENARIO FEATURES 

Incorporate the following features into a scenario for added realism. 

 Auto responses –move onto the next palette item automatically when virtual electric 
therapy is detected 

 File sharing and lab reports – Send lab reports to the virtual monitor computer 

 Speech – add phrases or custom speech 

FILE SHARING AND LAB REPORTS 

The scenario can also automate the distribution of shared files and labs. Click “Add to scenario”, 
and then use the “File” and “Lab” tabs to select from available documents. For more information 
making files available for file sharing, go to page 106. To create a new lab report, go to page 59. 
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SPEECH 

Add realism to a scenario by integrating speech into the scenario. Click the Add to scenario button 
and select Speech. Then, select the type of speech and phrase using the drop down menus. 

 

AUTO RESPONSES 

The scenario auto-response settings move the scenario to the next palette when electrical therapy 
is detected. Electrical therapy can be applied by the facilitator via Virtual Shock panel or by the care 
provider using real medical equipment if the simulator supports it. 

Auto-responses advance to the next palette if the virtual shock is applied while a “wait 
indefinitely” palette is playing and the heart rhythm is “shockable”. 

 

The three response options are defined below: 

 Off - The scenario does not respond to the electric therapy. 

 Prompt - The software detects the electrical therapy and prompts the user for approval before 
advancing to the next palette. 

 Auto – Advances to the next palette automatically only if the electrical therapy meets the 
threshold specified 
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BRANCHING SCENARIOS 

Unlike linear scenarios, which progress from one palette to the next, branching scenarios allow the 
facilitator to alter the scenario’s trajectory in response to provider actions. To access the Branching 
window, click the “Go to Branching Scenario” button on the Scenario tab.  

 

BRANCHING SCENARIO OVERVIEW 

Use the toolbar controls to clear, load, and save a scenario, or to switch from branching back to 
linear scenarios. Click “Load Scenario” to access the preprogrammed branched scenarios.  

The preprogrammed scenarios are included in the “Quick Start Surgical Chloe” profile. 

 

The “Load Scenario” window is displayed. For this example, select the “Pelvic Mass in Pregnancy” 
branching scenario and click “Load”. 
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The “Pelvic Mass in Pregnancy” branching scenario will assess surgical decision-making in a 
patient with ovarian torsion in the first trimester of pregnancy. 

At the start of the scenario (Node 1), the patient’s vital signs are set to values consistent with the 
complication. The participants will have up to 15:00 minutes to diagnose the patient. Once the 
decision to go to the operating room is made by the participants, checkmark the request to move 
the scenario to Node 4. The participants will have 1 hour to complete the rest of the expected 
actions as listed in the “Surgical Chloe Workbook”. 

Detailed information about the objectives and expected actions by the participants is 
included in the “Surgical Chloe Workbook”.  

Node 1 is preprogrammed with three key event triggers. Checkmark the key events to fulfill the 
requests made by the participants. 

When a key event is check marked, the software will move to the node specified in the key event’s 
properties. The node activated by the key event will play the preprogrammed action (palette, send 
file, or speech) and then move the scenario to the next node as programmed within the node’s 
properties. The graphic below outlines the trajectory of each key event option and the overall 
course of the branching scenario.  
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CREATING A NEW BRANCHING SCENARIO 

Build new branching scenarios to expand the number of exercises available in a training program. 
The general process of creating a new branching scenario is the following: 

 Add nodes 1.

 Add palettes or scenarios to each node 2.

 Add paths links 3.

 Create key events to alter the progress and trajectory of the nodes within the scenario 4.

ADDING NODES 

Click the “Add node” button. 

 

Click the node’s identifier number to edit the node’s properties. 
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Enter a name for the node and a description, then click “Save”.  

 

ADDING PALETTES OR SCENARIOS TO A NODE 

Click “Add palette” to add palette items, actions, or speech to this node. 

 

Nodes can be programmed to play palette items, send files or lab reports to the Gaumard Monitors 
PC, and trigger a speech response from the simulator. Select the palette item programmed with the 
patient’s initial vital signs and then click “Add”. Go to page 30 for information on how to create a 
new palette item. 
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Node 1 is now programmed to play the Pelvic Mass 1 palette item. 

 

Create the following Nodes and add the palettes required to complete the actions noted. 

Node 
number 

Node name Action Item Name 

1 Initial State Play Palette Item Pelvic Mass 1 

2 Ultra Sound Send File Dermoid Cyst Ultrasound 

3 CBC Lab Send Lab Pelvic Mass Lab 

4 OR (Operating Room) Play Palette Item Pelvic Mass 2 

NODE DEFAULT PATH 

Each node is programmed with a default path activated after the last palette in the node expires. 
The default path for a new node is to end the branching scenario. Click on the “Time Limit” icon to 
change the node’s default path. 
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Configure the countdown timer and the “go to” point. Click “OK” to save. Reference the graph 
below to configure the “Time limit” settings for each node. 

 

Node 
number 

Node name 
Time limit 

(minutes) 
Go to 

1 Initial State 15:00 End 

2 Ultra Sound 00:01 Previous 

3 CBC Lab 00:01 Previous 

4 OR (Operating Room) 59:00 End 

 

KEY EVENTS 

Key events allow the facilitator trigger an alternate path. Click the “Add path “To add a key event. 

  

Click the “Edit” button to configure the path’s properties. 

 

Delete 

Copy 

Edit 
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Use the Edit Path window to name, sort, and create key events. First, type a description for the 
action and then click “Add”. 

 

The key event description is now added to the Key Events list. Lastly, select the node the key event 
will trigger from the “Go to” drop down menu. Click “OK” to save the changes. 

 

The key event is now programmed to trigger node 2. 
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Add the following key events to node 1. 

Key event action Go to node 

Order pelvic ultrasound 2 

Order CBC 3 

Decide to go to OR 4 

The scenario is now complete. Click “Save Scenario” to store the branching scenario in the current 
profile. 

 

Enter the scenario’s name and a description. Click Save. 
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LINKED ACTIONS 

A “Linked Action” is a type of key event triggered automatically by an event detected on the 
simulator. First, add a new path and then open the “Edit Path” menu. 

Click the “Linked Action” radio button. Then, select the type of event and set a threshold. 

 

Click “add” to create the new “Key event”. 

 

The “linked action” is now a “Key event”. 
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Set the “Go To” node and Click OK to save the changes. 

 

The linked action is now programmed into the branching scenario. 

 

Use the Virtual Shock panel to simulate electrical therapy intervention. 

Warning: 

Do not defibrillate or pace CHLOE with real medical equipment. Doing so will result in 
damage to the simulator’s internal components. 
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FACTORY PRESET SCENARIOS 

There are ten preprogrammed branching scenarios in the “Quick Start Chloe” profile. More 
information about each scenario including, simulation overview, lab results, and patient history is 
included in the “Surgical Chloe Workbook”. 

Scenario 
Name 

Description 

Ruptured 
Ectopic 

pregnancy 

Patient presents to the emergency room having been previously evaluated by the ER 
physician, who has already done a positive pregnancy test. She is complaining of 
abdominal pain. She is a 27-year-old G2P1 patient. She did not know she was pregnant 
until she arrived in the emergency room and was told about the pregnancy. She is 
sexually active without contraception. She has a history of chlamydia for which she was 
treated as an outpatient. She is on over-the-counter medications for seasonal allergies, 
no other medications. She has no known drug allergies. She smokes one pack of 
cigarettes per day. She consumes 5 or 6 beers per weekend. She denies any street 
drugs. Physical exam shows a somewhat diaphoretic patient with a heart rate of 120 and 
a blood pressure of 80/40. The lungs are clear; heart is tachycardic, otherwise 
unremarkable. Abdomen is tender. Pelvic exam showed tenderness in the right adnexa 
and some discomfort throughout the exam. 

Pelvic Mass 
in pregnancy 

The patient is a 38-year-old G2P1 at 10 weeks gestation. She presents to the 
emergency room with significant abdominal pain. On questioning, the patient will point to 
her right lower quadrant. If asked, the patient will report decreased appetite, positive 
flatus and increased pain when riding to the emergency room when the car went over 
bumps.  

The patient’s history includes one previous vaginal delivery at term. She had an 
appendectomy at age 17. She has no other hospitalizations. She has had no surgeries. 
Her medications include Prenatal Vitamins only. She is allergic to penicillin. She denies 
tobacco, she denies ethanol use, and she denies street drug abuse. Family history 
includes breast cancer in her mother with onset at 38, but is otherwise unremarkable.  

Upon physical exam, the patient will be distraught but cooperative with questioning. 
Cardio-thoracic exam will be unremarkable. Abdominal exam will demonstrate rebound 
tenderness; pain will be focused on the right. Bi-manual pelvic exam will demonstrate 
right adnexal pain and an adnexal mass. Vaginal exam will be otherwise unremarkable.  

Septic 
abortion 

The patient is a 25-year-old woman from a lower socioeconomic group. She presents 
with complaints of lower abdominal pain and fever. She was unable to access a licensed 
abortion care provider and underwent an illegal pregnancy termination two days prior to 
admission. She is not willing to admit this fact unless directly asked whether she had an 
illegal abortion. She will be evasive on all issues involving uterus and pregnancy but will 
be very clear, concise, and thorough on other topics. 

Patient has had vaginal bleeding and generally felt ill for one day. She has had no 
previous pregnancies. She had one admission as a child for a febrile seizure at age 2 
and another admission at age 22 for a motor vehicle accident. She is on no medications. 
She has no known drug allergies. She denies tobacco use, but consumes two or three 
beers on the weekend.  
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Scenario 
Name 

Description 

Von 
Willebrand’s 

disease 

No previous surgeries. No previous hospitalizations. No medications. No known drug 
allergies. No street drug use. There is no history of any bruising. There is not history of 
bleeding with teeth brushing. There is no family history of bleeding disorder. Exam will 
show copious vaginal bleeding originating from the cervix. There is no evidence of 
trauma. 

Post-
operative 

hemorrhage 
status post 
conization 

cervix 

Connie Cox is a 32-year-old patient who underwent conization of the cervix earlier in the 
day. It is now approximately 8:00 in the evening and the patient has presented to the 
emergency room. She was discharged to home in good condition this morning but has 
presented with vaginal bleeding post-operatively. Pathology report is pending. Pre-
operative evaluation included colposcopic directed biopsies of the cervix, which showed 
Cervical Intraepithelial Neoplasia (CIN2); the colposcopy was inadequate at the time. 

The patient has been evaluated by the ER physician and significant vaginal bleeding has 
been reported. 

Learners will be called to the emergency room by the ER physician urgently for this port-
operative patient with ongoing vaginal bleeding. By the time the learners arrive, the 
simulated patient will have lost approximately two liters and will be expected to have 
tachycardia and decreased blood pressure. Urine output has not been assessed. The 
patient is G0. She has had no previous hospitalizations. She is on hydrochlorothiazide 
for blood pressure. She is on no other medications. She is allergic to sulfa. She denies 
tobacco use. She denies street drug use. Exam shows copious blood in vaginal vault. 

Fire in the 
operating 

room 

The patient is a 48-year-old woman who has failed conservative therapy for her 
dysfunctional uterine bleeding. She is Gravida 2 Para 2 with no previous surgeries. She 
was offered multiple surgical options and selected vaginal hysterectomy. She has 
benign essential hypertension and is on a verapamil but is on no other medications and 
has no other medical conditions. She has no drug allergies, is a non-smoker, drinks four 
of five beers a week, and denies drug abuse. Family history is unremarkable. She works 
as a paralegal and lives at home with her husband and 2 teenage sons. 

Physical exam prior to surgery showed an enlarged uterus but was otherwise 
unremarkable.  

Hypoxia in 
the operating 

room 

The patient is a 34-year-old nulligravida patient who is undergoing a scheduled 
myomectomy. She desires conception and was unable to conceive for over 2 years. She 
stopped efforts at conception once the diagnosis of multiple uterine myomata was made. 
Plans have been made to resect these myoma to improve her chances of conception. 
Her past medical history is unremarkable. No previous surgeries have occurred. She is 
currently on oral contraceptive agents. She has no known drug allergies. Social history 
includes a 20-pack year history of smoking. She denies alcohol or drug abuse. Cardiac 
and pulmonary exams are unremarkable upon presentation. 

Cardiac 
arrest in the 

operating 
room 

The patient is a 45-year-old G4P4 patient who is emergently sent to the OR for an 
abdominal hysterectomy due to severe vaginal bleeding. She refused IV estrogen. Her 
blooding became suddenly worse today; previous outpatient work-up included an 
endometrial biopsy, which was benign. No previous surgeries have occurred. 
Medications include hydrochlorothiazide for hypertension and ibuprofen for chronic 
headaches. Social history includes a 40-pack year history of smoking. She denies 
alcohol use or drug abuse. 
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Scenario 
Name 

Description 

Anaphylaxis 
in the 

operating 
room 

The patient is a 20-year-old nulligravida patient who is undergoing a scheduled resection 
of a mature ovarian teratoma (dermoid cyst). The presumed teratoma was discovered 
one month ago at the time of an ultrasound for pelvic pain. The pain has resolved since 
the ultrasound. Her past medical history is unremarkable. No previous surgeries have 
occurred. She is on no current medications. She has no known drug allergies. Social 
history reveals that the patent is a college student. She denies alcohol use or drug 
abuse. 

Malignant 
hyperthermia 

The simulation will begin in the OR with the patient already asleep. The patient is a 35 
year old Gravida 2 Para 2 woman who is undergoing an hysterectomy or other surgery 
as designated by the simulation lab director. For hysterectomy, she had long-term 
dysfunctional uterine bleeding refractory to conservative therapy. She had no previous 
surgeries. Her only hospitalizations were for her two vaginal deliveries. She denied 
smoking and drug abused and consumes approximately two alcoholic beverages a 
week. She is a schoolteacher, married, and lives with her husband and children. Family 
history is unremarkable.  

Physical exam prior to surgery showed a normal cardiopulmonary exam, a 10 week 
sized uterus, no pelvic masses and was otherwise unremarkable. 

  

 



Surgical Chloe | User Guide | 59 

Lab  
Use the lab tab to create laboratory tests results to aid the participants during simulation. In 
addition, create new laboratory templates to supplement different types of scenarios. Once a 
laboratory report is created, send the file to the virtual monitor screen for the provider access during 
the exercise.  

 

CREATING A LAB TEMPLATE 

Navigate to the bottom of the tab and click “New Template”. 

 

Use the “Edit Lab Results Template” window to create new lab templates. Enter a name for the lab 
template followed by a description. 
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Create categories to group a series of tests in a lab report. From the “category” box click “Add” to 
name and create a category. Then, click “OK” to save. 

 

Click “add” on the “Single Entry” menu to create a new test under the current category.  

 

First, enter the name of the test, the unit, and decimal precision. 

 

Enter a “Normal Range” the provider to reference. The normal range is visible on the lab report. 
The “Allowed Range” restricts the minimum and maximum value that can be entered a test result. 
Click “OK” to add the new test. 
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Repeat the process to add more tests and categories. Click “Save” to create the new lab template. 

 

The new template is listed on the “Lab Template” section at the bottom of the Lab tab. Use the 
buttons on the left panel to edit or delete lab templates. 

 

CREATING A LAB REPORT 

To create a new lab report: 

Click “Create a New Lab Report” on the right panel. 
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The “Edit Lab Report” window is displayed. 

 

Select a “Lab Template” from the drop down menu. 

 

Enter a report name, a report time, and a description. In addition, select a color tag for the lab 
report on the right panel. Color tags aid the sorting of lab reports on the report list window. 
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Enter the test results in the “Value” column. Include any comments associated with the test 
performed. Lastly, click “Save” to create the lab report. 

Lab result values for each of the preprogrammed scenarios in the Quick Start Chloe 
profile are included in the Surgical Chloe Workbook. 

 

The newly created lab report is now listed in the “Lab Reports” section. Sort lab reports by name, 
template, description, or color tag. 

 

Click “Preview” to review the final lab report. 

 

The preview window also allows the printing of results for distribution and archiving. 
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SEND TO MONITOR 

Send the completed lab report to the virtual monitor screen to assist the care provider.  

First, select the report from the lab reports list. 

 

Click “Send to Monitor” button to transfer the lab report to the virtual monitor. 

 

An exclamation icon notifies the provider a file is ready for access on the Gaumard Monitors. 
Instruct the participant to click the patient menu drop down and select the lab report. 
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The lab report opens using the system’s default application. 

 

The letter Y represents a shared document. Click the “Stop Sharing button” on the right panel to 
remove the lab report items from the Gaumard Monitors menu.  

 

An editable copy of the lab report is stored inside the Gaumard_UI folder on the computer’s home 
screen. Go to page 106 for information on how to access other files from the Gaumard Monitor 
screen. 
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Speech 

PRERECORDED SOUNDS 

Select the Speech tab to trigger the simulator to speak aloud. The collection of speech and other 
sounds covers a wide range of simulated emergencies.  

Click the phrase button to have the simulator speak the phrase aloud. Alternatively, program the 
phrases into a scenario to have the simulator speak automatically (page XXX). 

 

STREAMING AUDIO 

Use the streaming voice feature to engage a realistic dialogue between the simulator and the 
provider. In addition, record and save custom phrases to be played back during scenarios 
automatically. 

Ensure that the headset and microphone is connected to the PC before starting the GaumardUI 
software. The headset minimizes echo and environmental noise to improve audio quality. 

Click the “More” button in the lower right corner of the “Speech” tab to access the streaming voice 
menu. Click the “More” button again to return to the prerecorded speech tab. 

 

If the “More” button is not displayed, please verify that the simulator is connected by 
serial number on the Setup> Options> Environment FIXED field. 
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STREAMING VOICE CONTROL WINDOW 

Click the “Streaming Voice Controls” button to open the streaming voice window.  

 

The streaming voice feature is a two-way “push-to-talk” communication. The communication 
controls are the following: 

 Mute - Stop the communication 

 Listen – Listen to the provider’s response.  

 Talk - Speak to the providers as the simulator’s voice  

 

Enable the “Voice Activation” feature to switch to the talk mode automatically when voice input is 
detected. Adjust the mic threshold to set the voice activation sensitivity. The higher the threshold, 
the less sensitive the microphone is; and vice versa. For instance, if the threshold is set to high, the 
voice input volume must be high to trigger the voice activation.  

In addition to the streaming voice control window, the Mute, Listen, and Talk buttons are located 
near the top of the screen. 

 

VOICE CLARITY 

To achieve better clarity: 

 Verify that the physical MIC control on your headset is set to high. 

 Use the “Output Gain” to increase the microphone volume as a last resource. To raise the 
output gain in increments, tap and hold the control, then slide to the desired level. 

 Enable “Microphone boost” from the Windows
®
 setting. For more information on the Windows

®
 

settings, go to page 147. 
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PRERECORDED SPEECH 

Create a library of custom recordings to play back as the simulator’s voice using the “Prerecorded 
Speech” feature. 

 

VOICE RECORDER 

To record a custom phrase: 

Click the “Rec” button and speak into the microphone. 

 

Press “Stop” to finish recording.  

 

Enter a name and click “OK.”  

 

The new phrase is listed under the “Prerecorded Speech” menu. 
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Drugs (Automatic Mode Only) 
The Drug tab is available in automatic operating mode only. Use the “Drugs” tab to apply the 
physiological effects and reactions of medications administered to the patient model. The 
physiologic model processes the drug’s properties, dosage, administration time, and interactions 
then adjusts the patient model vital signs accordingly. 

While operating in the automatic mode, select the Meds Profile to load the library of 
preprogrammed drugs. The built in drug editor allows facilitators to stay current with new 
medications or make changes to the properties of existing drugs. All of the preprogrammed drugs 
included in the library are found in the 2008 Handbook of Emergency Cardiovascular Care 
published by the American Heart Association.  

ADMINISTERING MEDICATIONS 

Follow the steps below to administer a medication directly from the medication tab. Begin by 
selecting a medication from the drug list. 

 

A brief description is displayed at the top of the window. The half-life, peak time and drug 
concentration values are listed in addition to the standard and over dose dosages.  

 

Enter the dose, units, route and rate (if applicable), and click “Administer”. 

 



70 | Surgical Chloe | User Guide

The “Proceed Drug” window prompts to confirm the dosage effects before applying them. Adjust 
the peak effect percentage and/or the dosage effect then click “Yes” to administer the drug. 

 

To turn off the Proceed Drug prompt, go to the menu bar and click Setup>Auto Responses then 
change Drug Model Effect to Auto. 
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The administered drug panel displays information on dosage rate, percentage of dose completed 
and total time of administration.  

 

In addition, if a drug interaction is detected, information about the effect and the interactor is 
displayed in the interaction status panel. 

 

Increase the warp factor to speed up the effect of a medication on the patient model. 

 

After the drug’s administration is complete, select the drug and click “Remove from list”. Drugs 
cannot be removed from the list during the administration process with the exception of IV 
infusions. However, the drug effects for each medication can be turned off. Click File > New 
Session to remove the drugs from the list and reset the patient model. 

Click Stop Infusion to pause the drug administration. During this state the IV infusion dose and/or 

rate can be adjusted or removed altogether if necessary. 
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Right click on the drug entry to show the drug effect menu. 

 

Select from the following options. 

 Unselect - Unselect a highlighted drug. 5.

 Current Effects - View the effect on the patient’s vital signs. 6.

 All effects - View all the available programmed drug effects for this medication. 7.

 Drug effect toggle -Turn the drug effect off/on. 8.

FLUID & GAS 

The automatic mode can process the administration of gas and/or fluids to the patient model.  

 

Select from saline, blood, or oxygen and the volume/concentration and rate. Click on “Start” to 
administer. 
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DRUG LIST MANAGER 

To add new drugs, edit or update existing items and program drug interactions, click the Manage 
Drug List button. 

 

Select a drug from the Medication List and click edit to view the medication’s properties. 
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ADDING NEW DRUGS 

First, go to the Details tab and create a palette item with vital sign parameters consistent with the 
effects of a standard drug dose. Then, create an additional palette for the effects of an overdose. 
The two palette items will be used later to program the medication’s dosage effect. For general 
information on creating a palette items go to page 30. 

 

 After creating the dose effect palettes, go to the drug tab and click the Manage Drug List 1.

button. 
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The Add New Medication window appears. A list of all the drugs included with the Meds Profile is 
shown on the right. 

 

 Type the name of the new drug under New Medication following this pattern:  Generic Name 2.
(Brand Name). 

 

 Enter the medication’s description and the dosage information. 3.

 

 Select the units and the administration route. 4.
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 Enter the drug’s Half Life and Peak time. If these numbers are unknown, use the approximate 5.
option. 

 

 Enter half maximal effective concentration. 6.

 

 From the list, select the dose effect palette created earlier and click the applicable dosage 7.
button to assign. Repeat this step to assign the over dose effect palette to the Over Dose 
option.  

 



Surgical Chloe | User Guide | 77 

 Select the threshold unit and adjust the value for each dosage effect. 8.

 

DRUG EFFECT TESTER 

After configuring the drug properties, click the Update Graph button to generate the effect-plasma 

concentration results. Continue to the next section to program interactors for this drug. 

 

DRUG INTERACTION EDITOR 

P using the Drug interaction editor. Click on the Drug Interactions button to begin. 

 



78 | Surgical Chloe | User Guide

Use the “Interaction Editor” window to program interactions between the medications stored in the 
drug library. When two or more medications preprogrammed to interact are administered, the 
physiologic model will adjust vital signs as a response of the interaction effect. 

 

ADDING AN INTERACTOR 

First, select the drug from the drug list that will be programmed to interact with the current 
medication and click Add. Information about the interactor drug is displayed in the Interactor Data 

window. 
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The drug is included into the interactors list. Repeat the process to add more drugs to the 
interactors list if necessary. 

 

Select the interactor and click Edit. 

 

Adjust the Max Alpha to modify the type of interactivity effect. Monitor the graph for a visual model 

of the plasma concentration. 

 Alpha = 1: Additive 

 Alpha < 1: Synergistic/Induction 

 Alpha > 1: Antagonistic/Inhibition 
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TEST PANEL 

Use the test panel to simulate the interaction between the drugs based on dosage and time of 
administration. 

 

First, enter the patient’s weight and then the dose for each drug. 

 

Next, enter the time of administration for each drug and click “Update Graph”. 

 

The results indicate that the maximum interaction effect (93.38 %) occurs at 01:27:03. The alpha at 
that point is 1.01 and the drug effect for each drug is reduced by 0.08%. Fine-tune the Max Alpha 
control and retest if the drug interaction effect is not realistic. 
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A time-effect graph is also generated from the test results. Tap and hold to draw a zoom area. 

 

Right click anywhere on the graph access the zoon and print options. 

 

Click “Finish” to save the settings. 
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Lastly, review all the properties of the new medication and click Add to save. 

 

In the example below, two drugs have been administered preprogrammed to interact. The 
automatic mode has detected the interaction and displays additional information in the “Interaction 
Status” panel. 
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Log 

Use the Log tab to keep track system events and record provider actions. The Log tab is divided 
into four areas: the text log, provider action buttons, team selector, and session information.  

 A log entry is generated automatically every time the patient’s condition is changed and when the 
simulator’s sensors detect interaction. 

 

TEXT LOG 

The text log panel records time-stamped event entries. Event entries include Events Actions, 
Applied Changes, Detected Events, Evaluations, Speech, and Notes.  

 

ACTIONS 

Actions refers to those performed by one of the providers in the session. The facilitator can quickly 
log actions from the Provider Actions section and make the entry more specific using the Team 
Logging feature. The following is an example of an Action entry: 

"00:00:14  [Patricia] Action (Assess responsiveness)" 

APPLIED CHANGES 

An “Applied” log entry occurs automatically every time there is a change to the physiological 
condition of the simulator. In other words, every time changes are made from the Details page, 
Palette page, or from a scenario, a log entry like the following is created: 

"00:00:56  Applied (00:00): {Details: Rhythm 1st deg. AVB;}" 

DETECTED EVENTS 

A detected event is recorded every time the simulator’s sensors register an interaction. These 
include intubation, artificial ventilations, and chest compressions.  

00:00:19    Detected (chest compression):  peak = 86 mmHg , duration = 0.2 seconds. { 
depth = shallow } { duration = correct } 
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EVALUATIONS 

Evaluations are added by the facilitator by clicking on the “Satisfactory” or “Unsatisfactory” buttons 
on the Evaluation panel. Team Logging allows the facilitator to evaluate individual providers with a 
single click. For example, if provider Chris did a correct procedure, the Evaluation entry would be: 

"00:01:52  [Chris] Evaluation (Care Provided): Satisfactory" 

SPEECH 

When the facilitator makes CHLOE speak from the Speech page, an entry in the text log is 
automatically generated: 

"00:2:04  Speech (Urgency): "Don't touch me" 

NOTES 

Notes can be entered directly from the Evaluation panel or by right-clicking on the text log and 
adding a note. The following is an example of a Note entry: 

"00:02:23  Note: provider took too long to assess patient." 

PROVIDER ACTIONS 

The Provider Actions section refers to the collection of buttons in the middle of the page. It allows 
the facilitator to accurately keep track of provider actions. The buttons are grouped into five groups: 
Basic, Airway, Breathing, Circulation, and Medication. Anytime the facilitator clicks one of the 
buttons, a time-stamped log entry is generated with that particular action. For example, if the 
“Assess responsiveness” button is clicked when the session clock reads 00:07:24, the following 
entry is automatically generated: 

"00:00:14  [Patricia] Action (Assess responsiveness)" 

SPECIAL BUTTONS 

Some provider-action buttons are accompanied by a special option button. 

 

The first special button, “ + “, lets the facilitator log actions in more detail. For example, if the button 

“Call for assistance” is clicked, the following entry is created: 

"00:31:28  Action (Call for assistance)" 

On the other hand, if the “ + “ button next to “Call for assistance” is clicked, a list of additional 

options appears. The facilitator can be more specific and choose one of the three options: 

 

...and the following entry is added: 

"00:31:58  Action (Call for assistance) additional staffing" 
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The second special button, “ > “,  allows pre-programming common responses to specific actions. 

Take a look at the example below: 

 

When the “extubate” button is clicked, the following entry is created: 

"00:35:26  Action (Extubate): cough" 

MEDICATIONS (MANUAL MODE ONLY) 

The Medications section allows for easy and fast logging of drugs administration including dose 
and route. GaumardUI is preloaded with a set of commonly used drugs. Each of these drugs has a 
default dose unit and a default route for administration (which can be overwritten by just typing 
over). For example, for Adenosine the default dose unit is "mg" and the default route is "IVP" 
(intravenous push). In order to enter, for example, that a provider administered 6 mg of adenosine 
via IVP the facilitator just has to enter the text "ad" and the software automatically searches the 
drug list and displays the best match (if any). 

 

After a drug has been selected, just clicking on the “dose” text field automatically fills the units and 
route fields with the default values for that particular drug. 

 

The facilitator then enters the dose and clicks on the “Administered” button and a log entry is 
created (let's say the dose entered was “6”): 

"00:05:43  Action (Medication Administered): Adenosine, 6 mg, IVP" 
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TEAM LOGGING 

Use the team feature to track the actions of multiple providers in a simulation session.  

Click the “Add” button to add a new provider. 

 

Enter the provider’s name and select a color tag. Then click OK to save the changes. 

 

The provider is now added to the log tab. Repeat the steps to add up to six different providers. 

 

Click the provider’s name to set the provider as active. All subsequent event entries and actions are 
registered to the active provider. 
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Click the “Team” button to deactivate the active provider and return to general logging. Right click 
the provider button to delete or rename a provider. 

 

SESSION INFO 

The session info area contains the “Session Title” and “Facilitator” fields at the top of the page. 
These fields are included when a report is saved or printed. 

 

EVALUATION 

The Evaluation panel, always visible at the bottom of the GUI window, allows the facilitator to insert 
standard evaluations or arbitrary notes into the log. The stylus device and handwriting recognition 
technology makes annotating in real-time very fast and convenient. 

 

Standard evaluations are given context by their position in the log relative to detected and observed 
provider actions. The following example illustrates this idea. 

 

Note above that the provider "Josh Rossi" checked the patient's radial pulse and was then 
evaluated on that action. 

The evaluation panel is part of the team-logging system, described previously. When a particular 
provider is selected, log entries generated via the Evaluation panel will be recorded with the 
provider's name. For more information on Team Logging, see the previous section of this guide on 
Logging. 
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Evaluation Form 
The evaluation tool assists facilitators in reporting and assessing provider interaction using a 
questionnaire form. A completed evaluation form can then be stored as a digital document or 
printed for distribution. 

 

USING BUILT-IN EVALUATION TEMPLATES 

Several evaluation templates are built-in to GaumardUI’s evaluation tool. Each template includes a 
set of multiple choice questions related to the type of assessment being performed. 

Select an evaluation template from the Load Template dropdown. New templates created in the 
edit mode will also be listed. 

 

Enter the name of the facilitator performing the review in the On-Site Reviewer field. 
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Select from the multiple choice, written response, and true or false to complete the form. 

 

Click the Print button located at the top right corner of the screen once the evaluation is completed. 

 

To save the finished evaluation as digital document select Microsoft XPS Document writer and click 
“Print” to store a digital copy in the system. 
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Enter the evaluation name and click “Save”. 

 

PRINTING AN EVALUATION 

If the PC is connected to a printer, select and open the evaluation document saved in the previous 
step. 
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Navigate to the XPS Viewer file menu and select “Print”. 

 

Select the printer device from the list box and click print. 

 

It is recommended that documents are first saved as XPS files before being printed into hard 
copies. 
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CREATING NEW EVALUATION TEMPLATES 

Create new evaluation templates to tailor specific assessment needs. Template design and 
creation is done in the evaluation form edit mode. To enter the edit mode toggle the “Go To button” 
located on the top right of the evaluation form window. 

Enter the name of the evaluation template in the Evaluation Name field. 

 

Click “Add” on the Category menu. 

 

Select the category type and enter the category information title. Click OK to save the changes. 

 

The new category is listed.  
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Highlight the category and then click “Add” on the “Multiple Choice Entry” menu.  

 

Type the statement in the empty fields.  

 

Repeat the previous steps to add more categories, questions, and multiple-choice options. 
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After the evaluation template design is complete, click Save at the top of the window. 

 

The evaluation form is now available for use. 
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Menus 

File 

 

PROFILE 

This option allows you to change your 
current profile. The profiles dialog box 
displays the available profiles. A software 
restart is not necessary to switch between 
profiles. 

NEW SESSION 

Clicking New Session in the file menu will: 

 Clear any loaded/playing scenario 

 Clear any loaded/playing palette 

 Reset vital signs to normal values 

 Clear out log page 

 Restart the session clock.  

The session clock is located at the bottom of 
the dialog box. 

 

The shortcut key for staring a new session 
is: Ctrl + N 

RESET SESSION CLOCK 

Clicking on Reset Session Clock resets the 
clock back to zero. It does not have any 
effect on the transition time remaining on a 
scenario; it does not reset the vital signs, or 
clear out loaded scenarios. The facilitator 
can also reset the session clock by clicking 
on the Session button next to the session 
time. 

 

SAVE REPORT 

This option allows you to save all the 
information recorded in the log page as a 
text file. Clicking on it brings up the “Save 
As” dialog box: 

 

Select the desired name and path, and click 
“Save”. 

The shortcut key for saving a report is Ctrl + 
S. For a sample report, look at the figure 
below: 
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PRINT REPORT 

This option allows you to print a text file 
containing all the information in the log for 
the latest session. Clicking on “Print Report” 
brings up the Print dialog box. The shortcut 
key for this option is Ctrl + P. 

IMPORT 

This tool allows the import of palettes, 
scenarios or modeling patients that may 
have been created on another laptop PC. 

When Import is clicked, the “Open” dialog 
box is displayed: 

 

Browse to the location where the palette, 
scenario, or patient files were saved and 
open it. Imported files are saved 
automatically into the GaumardUI active 
profile. 

Make sure that you have the correct file type 
selected: 

 

EXPORT 

You can export palettes, scenarios 
(branched or linear), and model patients. 
After selecting the kind of file to be exported, 
the following dialog box is displayed. 

 

 

Make a selection and click “Export”. The 
“Save As” window is then displayed. 

 

Once the files are saved on to the flash 
drive, plug the drive to the computer where 
the files will be imported. From the 
GaumardUI, select import from the file menu.  

Navigate to the location where the file was 
saved on the flash drive and click open. 
GaumardUI will copy the scenario to the 
computer during the import process. 

EXIT 

Exit the software at any time by going to File, 
Exit or by clicking the red “x” button at the 
top right corner of the user interface. 
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Set-up 

 

CALIBRATION 

Use the Calibration menu to calibrate the 
simulator’s sensors. First select the feature 
to calibrate: chest compressions, artificial 
ventilations, or blood pressure cuff, then click 
”Next”. 

Chest rise will stop when the 
“Calibration” menu is opened. 

 

The procedures for each specific calibration 
are described in the sections below. 

CHEST 
COMPRESSIONS/ARTIFICIAL 
VENTILATIONS 

This tool helps you calibrate the chest 
compressions and the artificial ventilations to 
your specific criteria. That is, you will be 
telling the system what a correct chest 
compression is and/or what a correct 
artificial ventilation is. Providers will be 
evaluated by the system based on this 
criteria. 

The chest compressions and ventilations are 
calibrated the same way. After making a 
selection, this dialog box is displayed: 

 

Click next to proceed with the calibration.  

The software will now ask you to perform a 
number of “correct” chest compressions or 
artificial ventilations, depending on what you 
are calibrating. 

 

The facilitator should follow the text cue on 
the screen to perform just ONE compression 
or ventilation at a time, until prompted for the 
next one. 

For example, if calibrating chest 
compressions: 

 

The wizard prompts you with a “#1”. 

 Perform one correct chest compression. 1.

A green filled oval indicates that the chest 
compression was recorded successfully. The 
wizard prompts you with“#2”. 

 Perform a second correct chest 2.
compression. 

A green filled oval indicates that the chest 
compression was successfully recorded. 
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 Continue the process. 3.

At the end of the calibrating session the 
wizard shows the average peak, depth, and 
duration values for the procedure. If you feel 
you performed the procedures correctly, click 
the “Save” button. Otherwise, press the 
“Back” button to repeat the calibration. 

Notice that you can go back, abort or cancel 
at any time during the procedure. 

BLOOD PRESSURE CUFF 

Blood pressure cuff calibration should be 
performed only when the Korotkoff sounds 
do not match the systolic and diastolic 
values set from the computer. To calibrate, 
place the blood pressure cuff on the arm you 
wish to calibrate, right or left. Remember to 
connect the cuff's Luer-Lok connector to the 
simulator's shoulder. 

 

Follow the prompt to set the BP cuff to the 
pressure indicated on the screen. Hold the 
pressure constant and press the “OK” 
button. Follow the text cue on the screen and 
repeat the procedure for each pressure level 
until "Done" is displayed. 

 

For example, if calibrating the left arm: 

 

 The wizard prompts you with "0 mmHg." 

 Set the pressure on the BP cuff to 0 (i.e. 1.
cuff valve open). 

 Click the “OK” button. 2.

A green filled oval indicates that the value 
was successfully set. The wizard then 
prompts you with "20 mmHg". 

 Set the pressure on the BP cuff to 20 3.
mmHg. 

 Click the “OK” button. 4.

A green filled oval indicates the value was 
successfully set. 

 Continue the process. 5.

Once the prompt reads “Done”, go back and 
calibrate another function or click the “Finish” 
button to close the calibration wizard. 

OXYGEN SATURATION  

Use the calibration menu to calibrate the 
simulator to work with a specific oxygen 
saturation monitor and sensor. GaumardUI 
only stores calibration settings for one device 
at a time. If the monitor or the sensor is 
changed, please recalibrate the simulator to 
work with the current device. 

 

Disclaimer: Oxygen saturation 
monitors that detect carbon monoxide 
and/or methemoglobin are not 
supported. 

To calibrate the oxygen saturation finger: 
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 Turn OFF the oxygen saturation monitor 1.
and place the oximeter sensor on the 
left index finger. Verify that the left index 
finger is centered inside the oxygen 
sensor. 

 Go to Setup>Calibration and select 2.
“Oxygen Saturation”. Click “Next” to 
continue. 

 Verify which finger will be calibrated and 3.
then click “Next”. 

 Turn ON the oximeter and click “OK” on 4.
the dialog box. 

 Using the arrows on the left column of 5.
the calibration dialog box, adjust the 
reading on the oximeter monitor screen 
to match the value displayed on the 
GaumardUI calibration screen. The first 
calibration point is 98%. 

Use the triple arrows to increase or 
decrease the reading on the oximeter in 
large intervals. Use the double arrows 
for moderate changes and the single 
arrows for small changes of one or two 
percent readings. 

 

Always wait 10-15 seconds after making 
an adjustment to allow the oximeter 
reading to stabilize. This ensures proper 
calibration. 

 After the value on the oximeter screen 6.
stabilizes and matches the value on the 
GaumardUI screen Click “OK”. Then, 
click “Next” to continue. 

 Using the GaumardUI controls, adjust 7.
the reading on the oxygen saturation 
monitor to match the value on the menu 
screen. The first calibration point is 
98%. 

 Repeat the process until reaching the 8.
end of the calibration process. 

 Click “Finish” at the end of the 9.
calibration. 

TESTING THE OXYGEN 
CALIBRATION 

To test the calibration:  

 Go to the details page and vary the 1.
oxygen saturation value on the software.  

 Observe that the oximeter reading 2.
coincides with the value shown on the 
status panel (±3 differences are 
acceptable on readings above 80%).  

 Test calibration at two points; values 3.
between 80% and 95% are 
recommended. 

 Now take the oximeter sensor off the 4.
finger, wait for five seconds, and place 
the sensor on the finger again in the 
same position used during the 
calibration process.  

 Check that the oximeter reading 5.
coincides with the value specified on the 
Details page (±3 % value differences 
are accepted). 

If both readings do not coincide, make sure 
to slide the finger all the way into the 
oximeter sensor. If the reading still does not 
coincide, the feature was not calibrated 
properly. Please repeat the calibration 
process. 

FACTORY SETTINGS 

Factory Settings menu is used to restore 
sensors back to factory settings, over-riding 
any calibrations performed by users 

 

Make sure that when you are restoring the 
sensors to the factory settings that no one is 
practicing chest compressions, ventilations, 
intubation or auscultating the blood pressure. 
Any of these actions may interfere with the 
sensor resets.  
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Click the sensor button to reset it to the 
factory value. Should the Sensor not 
respond, please refer to the troubleshooting 
guide or contact Technical Support.  

 

At the end of calibrating a function, the 
Calibration Wizard resets the simulator for 
the changes to take effect and displays the 
message "Done". If the wizard displays the 
message "Can't reset", it simply means that 
the new calibration values will take effect 
next time you start the software. If the 
changes need to take immediate effect, 
simply close the GaumardUI software, wait 
about one minute (for the simulator to turn 
off), and then start the GaumardUI software 
again. 
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OPTIONS 

Open the Options menu to enable and 
disable features, drop-down menus, and 
configure software behaviors. 

 

ENVIRONMENT 

This tab allows you to choose how many 
CHLOE‘s you have in your facility. Notice 
that if the “FIXED” button is selected, you 
must enter the correct simulator's serial 
number in the text box. If you cannot find the 
serial number try connecting to the CHLOE

 

using “GENERIC” and then press on the 
button that says “Can't find Serial Number” 
and follow the instructions. 

GENERAL 

This tab allows the facilitator to: 

 Enable auto saving of the log 

 Save your current log report 

 Enable stand-by warning 

 Select units (SI or English) 

 Enable electrical therapy shock panel 

The shock panel is a floating window used 
for simulating electrical therapy. It can also 
be used in conjunction with “auto-
responses”. For more information, go to 
page 102. 

If the Electrical therapy panel is enabled, a 
new control will be accessible from the top 
right of the screen 

 

Use this control to bring focus to the floating 
shock/pace control window. 

 

CHLOE ADD-ONS 

Enter the activation code to enable upgrade 
features. Activation codes are unique to the 
simulator’s serial number. Before entering a 
code, go to the Environment tab and set the 
connection mode to FIXED, save the 
settings, then enter the simulator’s serial 
number. 

 Virtual Monitor – Enter the virtual 
monitor code to enable Monitor menu 
drop down for configuring the Gaumard 
Monitors connectivity 108. 

 Automatic Mode – Activate the 
Automatic mode and the physiologic 
model. 

SURGICAL CHLOE FEATURES 

On the Chloe Features tab, use the pulse 
strength control to fine tune the pulse 
intensity of the normal blood pressure value.  

CPR OPTIONS 

In this tab you can: 

 Select the number of desired 
compressions per minute 

 Specify the compression/ventilation ratio 

 Select number of ventilations per minute 
(if the ‘Only Ventilations’ button is 
selected)  
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TOLERANCES 

Use the Tolerances controls to adjust error 
margin allowed by the CPR intensity and 
rate. 

 

LOG 

Log event text entries are color-coded. Use 
the log tab to customize the color of each log 
entry type. 

 

OTHER 

Checkmark "Once a 'Palette' is applied load 
to “Details Tab'" to show the value of each of 
the palette’s vital signs parameters on the 
Detail’s tab control entries. 

Checkmark the “Link respiration sensor to 
ECG leads sensors”  

AUTO RESPONSES 

The Non-Scenario Automatic Response 
feature allows the facilitator to set 
preprogrammed responses to electrical 
therapy events. When the electrical therapy 
is detected, auto-responses can 
automatically load a specific palette item or 
prompt the facilitator before making 
preprogrammed changes to the simulator’s 
vital signs.  

Non-scenario response settings only detect 
electrical therapy administered when a 
scenario is not in progress. For information 
on how to configure auto-responses for 
scenarios, go to page 45. To activate the 
virtual shock panel, go to page 101. 

Do not defibrillate or pace the 
simulator with real medical 
equipment. Doing so will result in 
damage to the simulator’s internal 
components.  

 

The behavior of each auto response option 
is explained below. 

 Off - The software does not respond to 
the electric therapy 

 Prompt - The software detects the 
electrical therapy and prompts the 
facilitator before applying the changes 
configured in the “Settings” section. 

 Auto - The software automatically 
detects the electrical therapy and 
compares it to a threshold selected by 
the provider. If the threshold is met, the 
vitals will automatically change to the 
parameters specified on the “Settings” 
section. 
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Each type of electrical therapy has a unique 
set of default parameters. For example, the 
default response to a virtual defibrillation 
Shock applies the following vital sign 
parameter changes: NSR, 75 bpm, BP 
120/80. Click on the palette button to 
program a specific palette item as the auto-
response. 

 

The “Load Palette Item” window is displayed. 
Select the desired palette and click “Load”. 

 

The desired palette is now displayed in the 
“Setting” section.  

 

The auto-response is now configured to 
automatically apply the “Healthy Resting” 
palette if a virtual defibrillation shock of 200 
Joules or greater is detected. 

AUTOMATIC MODE NON-
SCENARIO AUTOMATIC 
RESPONSES 

The additional auto-responses listed below 
are unique to the automatic mode. 

Link All Auto Response to Cardiac Irritability 
- Auto-responses will work only if the cardiac 
irritability option on the details page matches 
the selection on this window.  

 

The following message is displayed if 
electrical therapy is detected and the cardiac 
irritability on the details page does not match 
the selection on the responses window. 

 

Drug Model Effect – Configure the auto-
response behavior when the administration 
of a medication is detected. 

 Auto – Apply the drug effects based on 
medication’s programmed properties 
and dosage.  

 Prompt – Display a confirm prompt 
before applying the drug’s effects. 
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Modeling (Automatic Mode 
Only) 

The “Modeling” drop down menu in the top 
left corner of the GaumardUI contains four 
options:  Modeling Patient, Reset Model, 
Import Between Patients, and Auto Log 
Setting. 

 

MODELING PATIENT 

This option allows you to create a new 
patient or load an already existing one. 

 

To create a new patient, go to Modeling, 
Modeling Patient, new patient. The following 
dialog box is displayed: 

 

Enter the name of the patient, age, gender, 
height, weight, and/or additional notes. Then, 
click “Save”. 

To load an already existing patient, go to 
Modeling, Modeling Patient, Load Patient. 

 

Select the desired patient, and click on Load. 
Notice that the factory pre-set patient Chloe 
cannot be deleted, as opposed to any of the 
patients that you create yourself, which can 
be deleted. 

Patient information is displayed on the right 
side and near the top of the Details tab. 

RESET MODEL 

Clicking on Reset Model under the Modeling 
drop down menu, will restore all vitals and 
physiologic controls to normal state. For 
instance, if the ECG rhythm is currently on 
Ventricular Fibrillation, clicking on reset 
model changes the ECG rhythm back to 
sinus.  

IMPORT BETWEEN PATIENTS 

Use the “Import between patients” menu to 
import palettes, scenarios, and branching 
scenarios from other patient profiles into the 
current active one.  

 

To begin, select the item category to import. 
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Then, select the patient name that contains 
the items that will be imported into the active 
patient. 

 

Select one or more palettes to import from 
the list and click “Import”. 

 

The palettes are now imported and saved 
into the CHLOE patient. 

 

AUTO LOG SETTING 

This menu option is used to specify various 
vitals to be logged automatically after 
reaching a specific threshold. 

 

Monitors 

Use the Monitors drop down menu to 
enable/disable sensors on the virtual monitor 
screen, share files, program custom scalars, 
and verify the connection between the 
GaumardUI and Gaumard Virtual Monitor 
software. 

 

If the “Monitors” drop down is not 
showing, go to Setup>Options> Add-
ons, and checkmark “Use Virtual Vital 
Signs Monitor.” 
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SENSORS 

Use the sensors option to enable or disable 
any of the waveforms displayed in the vital 
signs monitor. Select the waveform and click 
“ON” to display the readings on the virtual 
monitor screen. To disable a parameter 
reading, click “OFF”. The vital signs monitor 
sensors defaults to “All On.”   

 

Some sensors, such as NIBP and 
Thermometer feature a STAT control that will 
allow the facilitator to activate readings on 
the virtual monitors from the controller 
software. 

SENSOR CONTROL WINDOW 

The sensor control window is a floating panel 
with on/off toggle controls. Click Monitors> 
Sensors> Window to open the floating 
sensor control panel.  

 

Single click the circular icon to enable or 
disable the sensors displayed on the virtual 
monitor screen. Click the circle dark to 
disable the sensor and light blue to re-enable 
it. In the example above, all the sensors are 
on except the thermometer. 

FILE SHARING 

The file sharing menu allows the facilitator to 
send images, audio, and text files to the 
virtual monitor screen. Use the file sharing 
feature to fulfill file requests by the provider 
during simulation. 

To begin, first add the mock image (.jpg, 
.bmp) or text files (.txt) into the Gaumar_UI 
folder located on the home screen of the 
control computer. 

 

On the GaumardUI menu bar, click 
Monitors>File sharing, to open the “File 
Sharing Setup” menu. 

 

Use the “File Sharing Setup” menu to 
manage files shared with the virtual monitor 
software. The list of files stored on the 
Gaumard_UI folder available for sharing is 
displayed on the left panel. To share a file, 
first select the file from the left panel and 
click the “Add” button.  

 

Enter a context name on the pop-up menu 
and click “OK” to share. 
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Files currently shared are listed on the 
“Shared Files” list.  

 

Once a file is added to the “Shared Files” list, 
a yellow notification icon is shown on the 
patient menu at the top left of the virtual 
monitor screen. The icon notifies the 
provider that a file is available for viewing. 
Click on the patient name button to bring 
down the selection of available files and 
select the context name to open. 

 

The x-ray file is now open. 

 

To troubleshoot file sharing access errors, 
please reference the Gaumard Monitors user 
guide. 

CUSTOM NUMBERS 

Use the custom numbers feature to add 
custom numerical parameters to the 
Gaumard Monitors screen. For example, 
glucose levels or platelets count.  

On the GaumardUI menu bar click 
Monitors>Custom Numbers to open the 
“Custom Numerical Parameters on Monitor” 
menu. Click the “Add” button to create a new 
parameter. 

 

Type the name and units of the new 
parameter and then click “OK”. 

 

The scalar parameter is now created. Enter 
a value for the parameter and click “Update”.  

 

On the virtual monitor screen, click on a 
scalar’s menu and select “Close” to make 
the entry available for the custom parameter.  
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The scalar entry is now a blank field. 

 

Click on the empty scalar menu and select 
“Other” from the list of available scalar 
parameters. Select the name of the custom 
parameter. 

 

The figure below shows two new values:  
Glucose level and hematocrit levels. Return 
to the custom parameter menu on the 
GaumardUI software to update the values 
when necessary. 

 

CONFIGURATION 

On the GaumardUI menu bar, click 
Monitors>Configuration, to open the virtual 
monitor setup window. Use the virtual 
monitor setup window to verify the 
connection between the GaumardUI 
software and the Gaumard Monitors vital 
signs software, re-configure the 
communication ports and view the controller 
IP address. To troubleshoot connectivity 
issues, please turn to page 147. 
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CPR 

GaumardUI features a CPR performance 
evaluator and trainer. On the menu bar, click 
CPR>Evaluator to access the CPR Evaluator 
window. 

 

The CPR evaluator feature provides real 
time feedback on the provider’s compression 
and ventilation performance. 

 

The provider performance indicator boxes 
are located on the right. The V (ventilation) 
and C (compression) box fill color changes 
between the following states: 

 

 Grey – No intervention was detected. 

 Yellow – Compression was too shallow. 

Ventilation was too weak. 

 Green – Compression/ventilation was 

performed correctly. 

 Red – Compression was too deep. 

Ventilation was too strong. 

Compression and ventilation data is 
displayed at the bottom of the window as 
CPR is performed by the provider. 

 

Compression Data 

 Rate – Rate of compressions in real 

time. 

 Ct – (Compression time) – Average 

length of each compression in seconds. 

 LC – (Last Compression) – Time 

elapsed since the last compression 
performed. 

Ventilation Data 

 Rate – Ventilation rate in real time. 

 PIP – (approx.) Peak Inspiratory 

Pressure 

 Ti – Time Inspiration 

 I:E – Inspiratory: Expiratory Ratio 

 PEEP – (approx.) Positive end-

expiratory pressure 

 LV – (Last Ventilation) – Time elapsed 

since the last ventilation performed. 
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TRAINER 

The CPR trainer reference boxes generate a 
visual prompt of the compression to 
ventilation ratio programmed in the “CPR 
Options” menu. Click the “Trainer” button to 
start. The V (ventilations) and C 
(compressions) box borders blink to indicate 
the correct reference CPR rate. 

    

CPR OPTIONS 

By default, the CPR trainer is configured to 
blink the reference borders at a 30:2 
compression to ventilation ratio. To change 
the ratio, navigate to the menu bar and click 
the CPR dropdown and CPR Options. 

 

PERFORMANCE EXAMPLES 

Compressions are too shallow. Waveforms 
mostly do not reach the green zone. 
Compression indicator is yellow. 

 

Compressions are too deep. Waveforms 
mostly exceed the green zone. Compression 
indicator is red. 

 

Compressions are performed correctly. 
Waveform peaks are mostly inside the green 
zone.  

 

Ventilations are too shallow. Waveform 
peaks do not reach the green zone.  

 

Ventilations are too strong. Waveform peaks 
exceed the green zone. 

 

Ventilation was performed correctly. 
Waveform peak is inside the green zone. 
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Help 

On the menu bar, click the “Help” option to 
perform the following options. 

GUI HELP 

GUI Help option opens a digital copy of the 
simulator’s User Guide. 

ABOUT GUI 

Click “About GUI” for information on the 
GaumardUI software version and the 
simulator’s firmware revision. 

 

CHECK FOR UPDATES 

 Redistributable GaumardUI installer files 1.
are available for download at 
http://www.gaumard.com/software-
updates/. Follow the steps below to 
check for software updates using the 
built in update feature. 

 Connect an Ethernet cable to the laptop 2.
PC. 

 Go to the Help menu, and click on 3.
Check for Updates. The GaumardUI 
automatically starts searching for 
available updates. 

 Click “Install” to begin the update. The 4.
download progress bar begins to auto-
fill as the setup file is downloaded. 

Upon completion, the software automatically 
launches the setup wizard. 

 Click “Next”, and follow the wizard 5.
instructions to complete the software 
download. 

DIAGNOSTICS 

Use this feature as a troubleshooting tool to 
verify the status of the simulator’s features. 
For more information on using the 
diagnostics screen for troubleshooting, go to 
page 147. 

 

http://www.gaumard.com/software-updates/
http://www.gaumard.com/software-updates/
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Working with Surgical 
Chloe 
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Category Feature 

Airway Nasal and airway intubation 

Airway sounds 

Breathing Respiratory patterns 

Anterior lung sounds 

Bilateral chest rise and fall 

Pulmonary ventilation: BVM, mechanical 

Cardiac Audible heart sounds 

Electrocardiogram sites 

Compressions and ventilations are detected and logged 

Circulation Bilateral Pulses – carotid, brachial and radial 

Bilateral IV arms 

Blood pressure with Korotkoff sounds – Left arm 

Intramuscular injection placement sites 

Systemic Oxygen saturation on left index finger 

Eyelid state Open/Close (manual) 

Supine or semi-recumbent positions 

Surgical Abdominal wall insert 

Laparoscopy abdominal wall 

Bowel overlay insert 

Ovarian arterial and venous bleeding 

Uterine arterial and venous bleeding 

Uterine Assembly 1: Normal Uterus with ectopic pregnancy and uterine 
bleeding 

Uterine Assembly 2: Enlarged Uterus with dermoid cyst on one side and 
ectopic pregnancy on the other 

Uterine Assembly 3: Enlarged uterus with embedded fibroids, endometrioma 
on one side, and simple cyst on the other 

Other Streaming audio 

Virtual vital signs monitor 

PRO+ Audio, video and debriefing control computer (S2100) 
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Airway 
NASAL AND ORAL INTUBATION 

Practice airway management techniques such 
as nasal/oral intubation, and suctioning. 

 

Procedure 
Recommended  
Device Size 

Intubation 
(Blade size) 

Miller 4 or MAC 3.5 

LMA Size 4 

Nasal Intubation 
8 mm outer diameter 
max 

Oral Intubation ETT 7 or 7.5 

Warning: 
Do not introduce liquids when 
performing nasal and oral intubation. 
Doing so will damage the system.  

Always lubricate the catheter with the 
silicone lubricant provided before 
intubating. 

AIRWAY SOUNDS 

Use the Detail tab parameter controls to 
change the upper airway sounds on the 
simulator. 

 

Breathing 
RESPIRATORY PATTERNS 

Use the Detail tab parameter controls to 
change the simulator’s respiratory pattern. 

 

ANTERIOR LUNG SOUNDS 

Use the Detail tab parameter controls to 
change the audible respiratory sounds on the 
simulator. 

 

CHEST RISE AND FALL 

Set the respiratory rate higher than zero to 
enable automatic bilateral chest rise and fall. 
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PULMONARY VENTILATION 

Ventilate the simulator using a bag valve mask 
or a mechanical ventilator. Set the respiratory 
rate to “0” to display chest rise during 
ventilation and receive feedback on the CPR 
window. Go to page 109 to learn more about 
the CPR window. 

 

Cardiac 
AUDIBLE HEART SOUNDS 

Use the Detail tab parameter controls to 
change the audible heart tones on the 
simulator. 

 

ELECTROCARDIOGRAM SITES 

Connect real EKG electrodes to the four 
conductive sites and monitor Chloe’s heart 
rhythm (Lead II) using a real heart monitor.  

 

  

 

Warning:  
Do not pace or defibrillate the simulator. 
Doing so will result in damage to the 
simulator’s electrical components. 

Use the virtual shock panel to simulate the 
administration of electrical therapy. Enable the 
virtual shock panel from the Setup > Options 
menu. 

 

SELECTABLE HEART RHYTHMS 

GaumardUI features a library of heart rhythms. 
Select the rhythm from the list and apply the 
change to view the waveforms on the monitor. 

 

CLEANING THE 
ELECTROCARDIOGRAM SITES 

Maintain the electrocardiogram sites clean for 
accurate readings. In addition, reference the 
following guidelines: 

 Always clean the conductive sites at the 
end of simulation. 

 Do not leave ECG electrodes attached for 
use the next day 
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 NEVER attempt to service or modify any 
of the electrical connections, especially 
those between conductive skin sites and 
the internal electronics. Discontinue use if 
any wires are found exposed with 
damaged insulation. 

 Use a gentle degreasing cleanser or soap 
and water to clean the electrocardiogram 
sites. 

 If dark traces appear on the 
electrocardiogram sites, use a pencil 
eraser to remove the traces and then 
clean with alcohol or soap and water.  

 Do not scratch the conductive patches 
with abrasive objects; doing so will cause 
irreversible damage to the conductive 
sites. 

 

COMPRESSIONS AND 
VENTILATIONS (CPR) 

Ventilations and compressions are measured 
and logged. For more information on the CPR 
trainer, go to page 109. 

 

Circulation 
PULSES  

Chloe is equipped with palpable bilateral 
carotid, brachial, and radial pulses. Pulse 
strength is blood pressure dependent. Use the 
Detail tab parameter controls to disable the left 
radial pulse. 

 

BILATERAL IV ARMS 

Use the bilateral IV training arms for bolus or 
intravenous infusions as well as for drawing 
fluids.  

 

Warning:  
Do not attempt to fill IV system without 
the drain connector in place. 

Always leave the drain port connected 
when injecting fluids into the system. 

Use only Gaumard provided simulated 
blood. Any other simulated blood brand 
containing sugar or any additive may 
cause blockage and/or interruption of 
the vasculature system. 

At the end of every exercise, purge 
vascular system with 70% isopropyl 
alcohol solution. Then, purge the 
system with air to dry the veins. 

To fill the arm vasculature for drawing fluids: 

 Locate the filling kit that includes the fill 1.
syringe, syringe adapter, and the drain 
tube with the pinch-clamp.  
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 Fill the syringe with water or simulated 2.
blood. 

 Connect the filling syring to an available 3.
white port  

 

 Connect the drain tube to the other port as 4.
shown and open the pinch clamp. Place 
the end of the drain tube into a container. 

 

 Depress the syringe until fluid exits the 5.
drain tube and all the air bubbles are 
purged.  

 

COLLAPSIBLE VEINS 

To simulate a patient with no accessible 
peripheral IV sites, connect the fill syringe only 
and pull the plunger to create suction. Doing 
so will collapse the veins. Disconnect the 
syringe tube from the arm port while 
maintaining suction. The port will seal, and the 
veins will remain collapsed. 

CLEANING THE IV ARMS 

Purge the arm veins with 70% isopropyl 
alcohol solution at the end of the day to 
prevent mold. Then, repeat the filling 
procedure with air to purge left over fluid and 
dry the veins. 

BLOOD PRESSURE WITH 
KOROTKOFF SOUNDS 

Measure the programmable blood pressure on 
the left arm using a standard sphygmo 
manometer. Use a real stethoscope to 
auscultate the Korotkoff sounds.  

Before using the blood pressure feature for the 
first time, complete calibration procedure 
outlined on page 98. 

To get a blood pressure reading: 

 Put the blood pressure cuff around the 1.
simulator’s upper left arm with the cuff 
mark at the medial site of the bicep 
brachii, about an inch (two cm) above the 
anterior elbow. 

 

 Inflate the BP cuff, and auscultate 2.
Korotkoff sounds using the standard 
techniques practiced on a human patient. 

Placing the cuff any differently might 
give an incorrect reading. To recalibrate 
the BP arm, go to page 98 
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INTRAMUSCULAR INJECTION 
PLACEMENT SITES 

Intramuscular injection sites for placement 
exercises are located on both deltoids and 
quadriceps. 

 

Do not inject fluids into the IM sites. The 
sites only allow for placement and 
technique exercises. 

 

Systemic 
OXYGEN SATURATION 

Use commercially available monitors to read 
oxygen saturation from the left index finger. 

Before using the oxygen saturation feature for 
the first time, complete OSAT calibration 
procedure outlined on page 98. 

 

Co-oximeters that in addition to reading 
oxygen saturation also read carbon 
monoxide (SpCO) and methemoglobin 
(SpMet) are not supported and may 
provide inaccurate readings. 

EYELIDS 

Manually open or close the eyes individually. 

SUPINE OR SEMI-RECUMBENT 
POSITIONS 

Chloe can be rested in supine or semi-
recumbent positions. 
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Surgical 
OVERVIEW 

Surgical Chloe is designed to address 
competencies in six different areas, including:  

 Patient care  

 Medical knowledge 

 Practice based knowledge and 
improvement 

 Systems based practice 

 Communication  

 Professionalism  

SURGICAL CHLOE WORKBOOK 

The Surgical Chloe Workbook bundled with 
this package includes supplemental 
information intended to enhance the surgical 
simulation exercises. Each section of the 
workbook includes the following information for 
each preprogrammed scenario: 

 Preoperative, intraoperative, and 
postoperative checklist forms. For 
more information, go to page 102. 

 Scenario exercise overview  

 Patient history 

 Laboratory test values 

 Simulation parameters 

 Expected actions by participants 

 List of personnel/props 

 List of competencies addressed by 
each scenario 

 Debriefing goals 

The Surgical Chloe Workbook also contains 
helpful information for implementing a 
comprehensive simulation scenario. Moreover, 
it lays out a template for the level of detail that 
makes simulation effective. It is not a 
substitute for a comprehensive understanding 
of the subject matter, and it is not intended for 
clinical decision-making. 

UTERINE ASSEMBLY OVERVIEW 

A uterine assembly is a removable insert 
designed to simulate the anatomy and tissue 
properties of the female reproductive system 
with pathologies. Chloe includes three unique 
uterine assemblies, Uterine Assembly 1, 
Uterine Assembly 2, and Uterine Assembly 3. 

Uterine Assembly 1 is preinstalled. For 
information on how to change or 
replace a uterine assembly, go to page 
129. 

UTERINE ASSEMBLY 1 

“Uterine Assembly 1” features a normal sized 
uterus with a ruptured ectopic pregnancy and 
uterine bleeding. 

Additional possible procedures include: 

 Treating an ectopic 

 Dilation and curettage 

 Treating a bleeding disorder 

 Vaginal or abdominal hysterectomy 

 Performing bladder repair 

 

“Uterine assembly 1” is equipped with pinch 
clamps used to occlude blood to the 
complication not used during an exercise. Prior 
to starting a scenario, open or close pinch 
clamps as needed for the applicable exercise. 

 

Feature Location 

Ectopic pinch clamp 1 

Uterine pinch clamp 2 

1 

2 
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RUPTURED ECTOPIC 

To allow blood flow to the ruptured ectopic, 
open the Ectopic Flow clamp (1) and close the 
Uterine Flow clamp (2). This will allow only the 
ruptured ectopic to hemorrhage when the 
venous flow is enabled via the GaumardUI 
software

 

UTERINE BLEEDING 

To allow blood flow through the cervix as in the 
case with Von Willebrand’s, open the Uterine 
Flow clamp (2) and close the Ectopic Flow 
clamp (1). This configuration will only allow the 
uterus to bleed when the venous flow is 
enabled. 

Always lubricate the surgical tools prior 
to performing a pelvic exam. Doing so 
will prevent damaging the uterine 
assembly. 

UTERINE ASSEMBLY 2 

“Uterine Assembly 2” features an enlarged 
uterus with a ruptured ectopic pregnancy and 
a dermoid cyst. Possible procedures include: 

 Treating an ectopic  

 Removing a dermoid cyst  

 Performing bladder repair 

 Suction curettage 

 Removing products of conception as 
in septic abortion  

 Performing a vaginal hysterectomy 
with morcellation or an abdominal 
hysterectomy 

“Uterine assembly 2” is equipped with a 
manual flow valve on the left ovarian artery. 
Close the Ectopic Flow clamp to disable the 
blood flow to the area if the scenario does not 
involve the ruptured ectopic. 

 

UTERINE ASSEMBLY 3 

Uterine Assembly 3 includes an enlarged 
uterus with embedded fibroids, an 
endometrioma, and a simple cyst. Possible 
procedures include: 

 Performing an abdominal 
myomectomy 

 Removing an endometrioma  

 Removing a Cyst 

 Dilation and curettage, suction 
curettage 

 Performing bladder repair  

 Performing a vaginal hysterectomy 
with morcellation or an abdominal 
hysterectomy 

 

GENERAL UTERINE ASSEMBLY 
FEATURES 

All three uterine assemblies include the 
following anatomical features: 

 Bladder 

 Ovaries 

 Fallopian tubes 

 Peritoneum 

Open  

Closed  
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 Perineum with integrated vagina 

 Ovarian and uterine arteries and 
veins 

 Ligaments: uterosacral, 
infundibulopelvic, round, and cardinal 

 

Each uterine assembly allows for several 
surgical procedures when performed in order. 
All three assemblies allow for the following 
procedures:  

 Unilateral oophorectomy 

 Conization of the cervix 

 Chromopertubation 

 Hysteroscopy 

Always lubricate the surgical tools prior 
to performing a pelvic exam. Doing so 
will prevent damaging the uterine 
assembly. 

Abdominal Covers 

Chloe includes two separate abdominal covers 
for laparotomy and laparoscopic exercises. 

 

LAPAROTOMY COVER 

The laparotomy abdominal wall covers the 
abdomen and holds the abdominal insert in 
place. 

 

The replaceable abdominal insert is designed 
to react like real skin when cut, clamped, or 
sutured. It simulates the look and feel of the 
skin, subcutaneous tissue, fascia, muscle, and 
peritoneum. 

The fascia allows for a Pfannenstiel incision 
and the subcutaneous layer has built in blood 
sacks that rupture when cut. 

 

One abdominal insert is preinstalled on the 
laparotomy cover. Each abdominal insert can 
be used to perform up to 4 surgical incisions. 
For information on replacing and installing a 
new abdominal insert, go to page 130. 

Do not use electrosurgical or 
cauterization tools on any of the uterine 
assemblies or abdominal covers. 

LAPAROSCOPIC COVER 

The laparoscopy cover allows participants to 
perform minimally invasive surgical exercises. 
The cover features 8 pre-placed ports that can 
be used to insert trocars.  

Always lubricate the surgical tools prior 
to insertion. Doing so will prevent 
damage to the laparoscopy ports. 
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For exercises focused on trochar 
insertion technique, use the 
Laparotomy cover instead. 

 

Preparing for a Scenario  

FILLING THE SIMULATED BLOOD 
RESERVOIRS 

Chloe is equipped with internal fluid reservoirs 
that supply the ovarian and uterine 
vasculatures with simulated blood. The blood 
reservoirs are located inside the right and left 
upper leg. The blood flow is activated using 
the GaumardUI software controls. 

Feature 
Fill port 
location 

Capacity 

Venous 
reservoir 

Left leg 
750 mL 

Arterial 
reservoir 

Right leg 
750 mL 

Only use simulated blood provided by 
Gaumard. Any other simulated blood 
brand containing sugar or additives 
may cause blockage and/or interruption 
of the vasculature system. 

To fill the internal reservoirs: 

 Disable the arterial and venous bleeding 1.
and set the simulator to stand-by to 
release the internal reservoir pressure. 

 

 In a separate container, mix the Gaumard 2.
artificial blood substitute with 1 gallon of 
water and shake vigorously until the 
product has fully dissolved. 

 Attach the filling adapter tube to the 60 cc 3.
syringe and fill it with simulated blood. 

 Connect, turn, and lock the filling syringe 4.
to the arterial reservoir port located behind 
the right knee and inject 750 mL of 
Gaumard blood substitute. 

 

 Connect, turn, and lock the filling syringe 5.
to the venous reservoir port located 
behind the left knee and inject 750 mL of 
Gaumard blood substitute. 

PRIMING THE UTERINE ASSEMBLY 

After the uterine assembly is installed and the 
reservoirs are filled, purge the vasculature of 
any trapped air that may occlude the blood 
flow.  

To purge the trapped air in the vasculature: 

 Disconnect the ovarian vein and artery 1.
from the right side of the abdomen only. 
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If the uterine assembly is equipped with a 
pinch valve, keep the artery connected and 
open the valve to allow the trapped air to 
escape.  

 Enable the ovarian and uterine 2.
vasculature blood flow using the Details 
tab controls. 

 

 Please wait until the blood flows through 3.
the arteries and veins purging the trapped 
air. The process may take up to 30 
seconds. 

 

 Reconnect the vein and artery. 4.

 

 Repeat the process to purge the uterine 5.
vasculature. 

 Disable the blood flow using the Details 6.
tab controls. 

 

Scenario Walkthrough 

RUPTURED ECTOPIC BRANCHING 
SCENARIO WALKTHROUGH 

The preprogrammed Ruptured Ectopic 
Scenario presents a hemodynamically 
unstable patient whose condition worsens 
unless the ruptured ectopic is treated in time.  

See the Surgical Chloe DVD for a 
complete walkthrough of this scenario. 
Additional information including patient 
history, laboratory results, and 
debriefing goals information is included 
in the Surgical Chloe Workbook. 

To prepare CHLOE for the ruptured ectopic 
scenario: 

 Install Uterine Assembly 1 or Uterine 1.
Assembly 2 

 Fill the arterial and venous reservoirs with 2.
simulated blood 

 Prime the uterine assembly 3.

 Open the ectopic flow clamp 4.

 Install the bowel insert 5.

 Install the laparotomy cover 6.

 Adjust the wireless cameras for a clear 7.
view of the operating table 

Each assembly allows for a minimum of 
four procedures. Carefully plan the 
order of procedures and exercises to 
increase the usability of each uterine 
assembly.  

GAUMARDUI BRANCHING 
SCENARIO SCREENS 

From the GaumardUI menu bar, click File > 
“New Session” to start a new event log file. 
Then, go to the “Quick Launch” and click 
“Ruptured Ectopic” to start the scenario. 

In the PRO+ (S2100) system, click File 
>”New Session” to start a new event log 
file and a new recording session. 
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To complete the scenario, the participants are 
to assess the patient in the ER, diagnose 
hemodynamic instability, diagnose the ectopic 
pregnancy, and quickly rush the patient to the 
operating room for a definitive surgical 
procedure. The team will have 20 minutes 
after onset of bleeding to achieve these goals.  

 

If the participants are not meeting the 
competencies and goals within the allotted 
time, the facilitator can choose to give the 
participants more time by check marking the 
"Stop Bleeding Option" to restart the current 
palette item and disable the bleeding. 

 

As the participants complete the 
competencies, checkmark the “Hemorrhage 
control”, and “Blood given” key events to move 
the scenario to “Node 2 - recovery”. 

 

The palette items programmed into “Node 2 - 
Recovery” improve the patient’s condition 
while the surgery is completed. 

Go to page 46 for information on how 
program new branching scenarios. 

SURGERY 

The Surgeon incises the skin of the abdominal 
insert using real surgical instruments.  

Do not use electrosurgical or 
cauterization cutting tools. Doing so will 
result in damage to the materials.  

 

The subcutaneous tissue is revealed as the 
skin is separated.  

 

The abdominal wall fascia is incised. 

 

The fascia is separated from the underlying 
rectus muscle. 
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The peritoneum is incised carefully. 

 

RECORDING USING THE PRO+ 

During the simulation, the PRO+ (S2100) 
system records the internal pelvic camera 
feeds, the surgeon’s view, the overhead view, 
and the patient’s vital signs screen. The audio 
and video information is synchronized with the 
GaumardUI event log and stored in the PC for 
debriefing. For detailed information about the 
PRO+ software, go to page 133. 

 

Switch to the PRO+ (S2100) recording screen 
for a larger view of the live procedure.  

 

Audience members can view a live 
video feed of the procedure from a PC 
connected to the PRO+ wireless 
network. For more information about 
the remote Dashboard feature, please 
go to page 142. 

The ectopic pregnancy is visualized. 

 

The bleeding ruptured ectopic is identified. 

 

The ectopic pregnancy is isolated. 

 

After clamping the fallopian tube, a 
salpingectomy is performed. 

 

The fallopian tube stump is ligated. 
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The suture is cut, knot integrity is verified, and 
hemostasis is achieved.  

 

Fascial closure of the abdominal wall is 
initiated. 

 

The skin is closure is completed. 
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Post Simulation 
Maintenance and Care 

After the simulation and debriefing session is 
over, complete the post simulation 
maintenance and care procedures to prevent 
mold and clogs in the vasculatures. 

 Remove the Uterine Assembly and clean 
the simulated blood residue 

 Purge the simulated blood from both 
reservoirs 

 Clean the reservoirs with distilled water 

 Drain the reservoirs 

REMOVING THE UTERINE 
ASSEMBLY 

To remove or replace the uterine assembly: 

 Disconnect all four ovarian veins and 1.
artery quick connect fittings. 

 

 Disconnect all four uterine veins and 2.
artery quick connect fittings. 

 

 Detach the Velcro that secures the 3.
assembly in place by carefully pressing 
down and around the outside of the 
assembly. 

 

 Slide the uterine assembly out the bottom 4.
of the torso. 

 

 Clean the Velcro and the abdominal cavity 5.
using a damp cloth with diluted soap and 
water. 

CLEANING THE FLUID 
RESERVOIRS 

Purge both internal blood reservoirs to prevent 
mold and clogging. Please remove the uterine 
assembly before continuing. 

Always purge and drain the arterial and 
vein reservoirs at the end of the 
simulation session. Doing so will 
prevent mold and buildup. 

To drain the remaining simulated blood: 

 Connect the drain tube to the arterial and 1.
vein ports 
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 Place the drain tube into a container to 2.
collect the remaining blood. For best 
results, position the container below the 
simulator  

 Enable to arterial blood flow using the 3.
Details page controls. 

 

 Allow the system to purge the simulated 4.
blood into the container. 

 

 Repeat the procedure to drain the 5.
remaining arterial and venous ports. 

 

 Leave the drain tubes connected to clean 6.
the system using distilled water 

To clean the system with distilled water: 

 Disable the blood flow and refill the 1.
arterial and venous reservoirs with 
distilled water using the fill syringe. 

 

 

 Enable the arterial and venous bleed 2.

 

 Allow the distilled water to drain into the 3.
container until clean water flows through 
the drain tubes 

 

 Repeat the procedure to flush the 4.
remaining arterial and venous ports. 

 Turn off the arterial and venous bleed 5.
when no more clean fluid is exiting the 
drain tube 
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INSTALLING A UTERINE 
ASSEMBLY 

Before installing the uterine assembly, clean 
and dry the Velcro attachments to prevent 
molding or staining. 

 Wrap the assembly’s Velcro fastener strip 1.
with the clear plastic bag that the uterine 
assembly was shipped in. 

 

 Align the uterine assembly with the pubis 2.
and coccyx. 

 

 Slide the uterine assembly into position on 3.
the torso. Make any final positioning 
adjustments needed and slide the plastic 
bag out.  

 

 Press the uterine assembly Velcro against 4.
the circumference of the pelvis to secure it 
in place.   

 Connect, turn, and lock the uterine 5.
arteries and veins quick connectors 
located in the lower torso. The quick 
connectors are color-coded; black 
connectors identify the arteries and white 
connectors identify the veins. 

Feature Connector color 

Artery white 

Vein black 

 

 To connect the ovarian veins and arteries, 6.
first loop the tubes into position to prevent 
kinks and then lock the connectors to the 
ports. 

 

 Check for kinks in the vasculature.  7.

Go to page 119 for information on the pinch 
clamps used to occlude blood and disable 
specific pathologies. 
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REPLACING THE ABDOMINAL 
INSERT 

The abdominal insert allows for up to four 
incisions. To remove and install a new 
abdominal insert: 

 Position the Laparotomy Abdominal Wall 1.
face down on a clean flat surface and 
remove the 6 nylon screws holding the 
abdominal wall Insert Support. 

 

 Remove the Abdominal Wall Insert 2.
Support. 

 

 Pull the Abdominal Wall Insert upwards so 3.
that the skin layer is brought through the 
surgical window. 

 

To install a new abdominal wall insert: 

 Align the Abdominal Wall Insert with the 1.
skin layer facing down and with the wider 
part of the skin flange pointing toward the 
pubic bone. 

 

 Fit the insert in the surgical window by first 2.
passing the skin layer through the opening 

 

 Align the thru holes of the Abdominal Wall 3.
Insert with those of the Abdominal Wall 

 

 Insert all the nylon screws through the 4.
Abdominal Wall and abdominal Insert so 
that the heads lay flat against the Skin 
surface of the abdominal wall  
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 Align and place the Abdominal Wall 5.
Support on the nylon screws 

 

 Secure the assembly using the acorn 6.
fasteners 
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Debriefing 
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PRO+ (Chloe S2100) 
The PRO+ PC is a convertible touchscreen PC pre-loaded with the GaumardUI control software 
and with audio/video recording capabilities. The system allows the facilitator to control the 
simulator’s vital signs, run scenarios, and record footage of the simulation simultaneously. After 
simulation is complete, review the footage with the participants on the virtual monitor PC to 
complete the debriefing.  

Reference the Surgical Chloe Workbook for information on debriefing goals for each of 
the preprogrammed scenarios in the GaumardUI software. 

 

The PRO+ system is the standard control PC included with the Surgical Chloe S2100 package. 
Before using the PRO+ system for the first time, please reference the setup information on page 14 
to ensure the simulator and the multiple cameras are connected properly. 

The PRO+ interface is divided into two screen modes; the GaumardUI simulator control mode and 
the recording and playback mode. Click on the ETC button to switch between the screen modes. 
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GaumardUI Mode 

The GaumardUI screen hosts the GaumardUI simulator control software. In addition, it displays four camera views, 
quick flags, battery status, and playback and recording volume controls. 

 

 GaumardUI Start Screen - Click start to launch 1.

the GaumardUI software and initialize the 
simulator. The PRO+ system will start to record a 
new session when GaumardUI is initialized.  

 Video Feed Panel - Monitor the video feeds 2.

while controlling the simulator. The pro+ system 
can displays up to four video feeds on the left 
panel at a time. 

 Video Feed Setup - Open the view setup menu 3.

to configure which video feeds are displayed on 
the left panel. To verify which cameras are 
connected to the PRO+ system, go to page 139. 

 Quick Flags - Click the flag shortcut to add a flag 4.

to the event log. Page 138. 

 Dashboard - Slide the menu down to access the 5.

Dashboard options. 

 Settings Menu - The settings menu is displayed 6.

on both screen modes. It provides quick access 
to configuration settings and information. Click 
the option to open the corresponding menu. Page 
139. 

 Battery status - The battery indicator displays 7.

the battery charge percentage. Keep the laptop 
connected to charger during lengthy simulations 
to prevent interruptions. 

The PRO+ system includes one battery. Please 
refer to the manufacturer’s documentation for 
information on how to install a secondary battery,  

 Record - Toggle the record button to start and 8.

stop the session’s recording manually. 

 Playback Volume - Adjust volume captured by 9.

the camera. 

 Capture Playback - Adjust the capture level of 10.

the built in microphones. Page 139. 

 Shut Down - Click the power button to shut down 11.

the laptop or to log off. The laptop pc does not 
tun off automatically when the lid is closed. To 
configure the power settings, go to page 141. 

 Screen Mode Toggle - Toggle to switch between 12.

the GaumardUI screen mode and the PRO+ 
mode. 

2 

5 

4 

1 

7 
6 

9 

11 

10 

12 

8 
3 
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PRO+ Mode 

The PRO+ mode features the controls and camera views to monitor session’s recording. The session recording 
stores multiple camera views, audio, patient vital sign readings, and event information. Click the screen mode toggle 
to switch between the screen modes. 

 

 Storage - The hard disk (hard drive) icon displays 1.

the amount of free space available on the system 
for recording. If the system hard drive nears low disk 
space, backup and delete recordings before starting 
a new session. To manage the session files, go to 
page 122. 

 Pan Tilt Zoom Controls - Use the PTZ controls to 2.

move pan-tilt-zoom capable cameras. 

 Video Display - The main video screen displays 3.

live feeds from each video source during a live 
recording or playback. 

 Recording/Playback Controls - Use the controls to 4.

start, stop a recording, and review session footage. 
For more information about the play/record controls, 
go to page 136 

 Progress Bar/ Seek Control - Use the progress 5.

bar to jump to a specific part of the recording. The 
PRO+ continues to record even when reviewing an 
earlier point during the session. 

 Live Feed - Click the LIVE button to return to the 6.

live video feed instantly. 

 Video Feed Distribution - Toggle the video display 7.

area between fullscreen, quad view, PIP, and tiled.  

 Display Configuration - Click the setup button to 8.

configure which camera views are shown on the 
video display. Page 136. 

 Video channel - Toggle the desired camera feed. 9.

 Event log - Monitor the event entries generated by 10.

the GaumardUI software. Click the specific entry to 
jump to that point in the video. Page 137. 

 Metadata - Edit the recording’s description and 11.

catalogue information. Page 137. 

 Visibility - Change the visibility permissions for the 12.

current movie. Page 137. 

 Playback Volume - Adjust the playback volume 13.

level. 

 File library - Click on the File Library icon to access 14.

all the session recordings and to export them for 
back up or distribution. For more information, go to 
page 138. 

 Eject DVD - If DVD drive is installed, click the “Eject 15.

DVD” button to open the DVD tray.  

 Shutdown - The PRO+ system does not 16.

automatically power down when the lid is closed. 
Click the “Shutdown” button to power down the 
system at the end of every session. 

1 

11 

3 

4 
5 
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Recording Controls 
The PRO+ system starts to record when the 
GaumardUI establishes a connection to the 
simulator automatically. To resume recording 
manually, click the record button. 

To start a new recording for a new scenario, 
go to the GaumardUI and click File, New 
Session. 

 

Click the stop button to pause the recording. If 
necessary, click back buffer button and start 
your recording two minutes prior to the actual 
start time. 

To access the session recording at the end of 
the simulation, go to page 138. 

LIVE 

Use the seek control slider to review earlier 
footage while recording and then click “Live” to 
return to the real time video feed. 

 

Display 
Configuration 
Toggle the viewing area between fullscreen 
and picture and picture. Click the display 
configuration icon to customize the main 
display distribution. 

 

Assign an active video feed to each of the four 
quadrants then click save. 
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Event Viewer 
The events list records the GaumardUI log 
entries and comments as markers on the 
session’s recording.  

During the session, click an entry to view 
footage of the event instantly. To return real 
time, click the “LIVE” button located on the 
playback control panel. 

The PRO+ system will continue to 
record while earlier events are 
reviewed.

To start a new scenario and event log, go to 
click File>New Session on the GaumardUI 
software. 

Metadata 

The Metadata information facilitates the sorting 
of session files in the File Library. Recordings 
can be sorted in the library by patient name, 
instructor, student, or type. 

Click the Metadata tab to edit the recording’s 
description and catalogue information. Click 
“Save” to store the changes. 

 

Visibility 

Use the Visibility tab group and protect videos 
from other users. The three types of visibility 
are, Global, Private and Group. The 
administrator has access to view all videos. 
Select the movie visibility option, then click 
submit. 

 Global - All users can view these videos.  

 Private - Only the creator and a selected 
list of users can view these videos.  

 Group - Only users of the same group(s) 
can view these videos.  
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Flags 

A flag is a bookmark for an event that occurred 
at a certain point in a scenario. There are four 
flag icons and an “Add New” button.  

To add a flag comment to the event list, click 
on the flag button available on both screen 
modes. 

To create a new comment, click the Add New 

button, and then type the desired text in the 
box. Click “submit” after the comment is 
entered. The flags or comments can be added 
at any time during recording or playback. 

File Library 
Click “File Library” to access the library of 
session recordings.  

 

Use the file library window to browse and 
manage the collection of session recordings 
stored in the PRO+ system’s hard disk. In 
addition, export session files to DVD, USB, or 
network drives for backup or distribution. 

Double click the dated entry and click play to 
playback session footage. The video file is 
stored in the PRO+ hard drive. 

 

EXPORTING VIDEO 

Backup session videos by exporting video files 
in .AVI format to DVD or to USB flash drives. 
Session files exported to a USB drive include 
the PC PRO+ video player that allows viewers 
to select from the multiple video feeds. Click 
“GO!” to begin the export process. 

 

COPY TO DISK 

To back up the session files as data, Select 
Copy to Disk to back up movie onto DVD, USB 
or network drives. Click “GO!” to begin the 
export process. 

Playback Controls 
The session footage playback controls are 
rewind, play backward, pause, play, and fast-
forward. Use the slider control to jump to a 
specific part of the video. 

 

VOLUME SLIDER 

Control the playback volume using the slider 
control. To mute the live/playback audio, click 
the mute icon.
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1NS, 10S, 20S 

The 1ns, 10s, and 20s buttons on the far right 
are used to see different samples of audio. 
Click on the 1ns button to see the audio in real 
time. Click on the 10s to see the audio in a 10 
second clip of time. Click on the 20s to review 
the audio in a 20-second segment.  

Settings Menu 
The settings menu is located near the top of 
the screen. Click the menu buttons to access 
the menu options and to configure PRO+ 
system settings. 

The audio, camera, and privacy streaming 
guard options are exclusive to the PRO+ 
screen mode.  

 

Cameras Setup 

Click the Camera Setup button to configure the 
cameras, the recording resolution. and monitor 
the recording bitrate. 

 

The wireless cameras included with the 
system are preconfigured with a fixed IP 
address and a network name ESSID.  

Plug in the wireless cameras to a power 
source before turning on the PRO+ PC. 

To establish a connection with a new camera, 
enter the wireless camera’s IP address and 
click the Enable Network Camera circle. 
Finally, click Submit Camera Settings to apply.  
 

 

Connect the wired cameras to any of the 
available USB ports. The Ultra Res (high-
resolution) mode option becomes available if a 
compatible wired camera is detected.  

The Data Rate meter is located at the top of 
the page. Reference the indicator to monitor 
how much video bandwidth is in use.  

If a lab-style camera is connected, the 
recording format option becomes available. 
Select the picture quality by changing the 
recording codec between Standard, High, and 
MPEG4. MPEG4 records the best picture 
quality but uses the most bandwidth and disk 
space. Keep an eye on the Data Rate meter if 
MPEG4 is in used.  

If the picture quality appears distorted, click 
the Camera Reset button to restart the 
camera. It may take a few seconds for the 
camera to complete the process. Resetting the 
camera will not change the camera settings. 

Note: Additional Wireless Cameras sold 
separately. 

Audio Settings 

Click the speaker icon to open the audio 
settings menu. Use the Audio Settings window 
to configure microphone input, equalizer 
settings, and preset filters.  
 

 

Enable the Pop Filter to reduce the recording 

of popping and crackling sounds. 

The graphic equalizer works like a noise filter. 
Adjust the frequency band sliders to reduce 
background noise and improve the audio 
recording. Click the Save to submit the 

settings.  
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Network Settings 

Click the Network Setup icon to view or 
configure the wired and wireless settings.  
 

 

WIRELESS NETWORK SETTINGS 

Select the Wireless tab to access the Wireless 

Network Configuration settings. The PRO+ 
system is configured to connect wirelessly to 
the other electronic peripherals included with 
the Gaumard package. 

The wireless settings are preconfigured 
at the factory to work with the wireless 
cameras. Changing the wireless 
settings may disconnect the camera 
feeds. 

MASTER ACCESS POINT MODE 

The Master (Access Point) Mode option is 

default wireless connection setting. This option 
simplifies wireless network configuration 
between the PRO+ system, virtual monitor 
computers, and wireless cameras by making 
the PRO+ computer the wireless point of 
contact. The Master Mode option system 
enables the DHCP and DNS service. 

The Master AP Mode setting allows the 
computers to communicate using a private and 
independent network.  

NETWORK NAME (ESSID) 

The ESSID or network name is programmed 
into all the peripherals included with the 
Gaumard package. Computers and wireless 
cameras connecting to the PRO+ system 
share the same case sensitive ESSID network 
name to locate each other. 

Do not change the ESSID name on the 
PRO+ system. Doing so will disconnect 
the wireless peripherals.  

CUSTOM WIRELESS 
CONFIGURATION 

Advanced users can manually configure the 
wireless settings by selecting the “custom 
Wireless Configuration” option. Use this option 
to join the PRO+ computer onto a pre-existing 
wireless ad-hoc network or access point. The 
DHCP and DNS services are disabled under 
this option. 

WIRED NETWORK SETTINGS 

Select the Wired (LAN) tab to configure the 
wired network configuration settings. To save 
settings, click “Submit”. 

 

DEFAULT 

Select Default (Private) Network Configuration 
to restore the network setting to the factory 
values. This network set up option also 
enables the DNS (name) and DHCP servers. 

CUSTOM NETWORK 

For advanced users and IT professionals, 
select the “Custom Network Configuration” 
option to configure the LAN network settings 
manually and join the PRO+ computer to an 
existing network, such as the company intranet 
and to access the internet for PRO+ system 
updates. This option disables the DHCP and 
NAME servers. 
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Power Settings 

Use the power settings to configure the PRO+ 
PC power and security settings.  

 

Checkmark “Shut off display when lid closed” 
to conserve during a session by allowing the 
system to continue recording the lid closed.  

Checkmark the “Require login for ETC laptop” 
option to prompt for administrator username 
and password credentials on startup. 
(Recommended) 

System Updates 

The PRO+ system receives separate updates 
for the GaumardUI control software and the 
PRO+ operating system. Reference the 
following information to update each platform. 

UPDATING GAUMARDUI 

First, from a computer with internet access, 
download the latest update install file from 
www.Gaumard.com to the root of the USB 
flash drive. 

 

The PRO+ update menu will only 
recognize Gaumard Update files saved 
on the root of the flash memory drive 
and with the original file name. 

To update the GaumardUI software: 

 Connect the USB Flash Drive to the 1.
PRO+ computer  

 Open the Upgrade System menu  2.

 Click the “update” button in the “Gaumard 3.
Simulation Software” section. 

 

 Select the update file from the menu and 4.
click “Update”.  

The system will display the update progress 
bar and restart once the process is complete. 

UPDATING THE PRO+ OPERATING 
SYSTEM 

The PRO+ operating system receives routine 
updates via wired network connection only.  

To configure the wired network LAN settings 
for your network, navigate to the Custom 
Network tab on the Network Configuration 

menu. Click the Update button when wired 
internet access is available. 

PRO+ operating system updates can 
only be performed through the wired 
connection. For assistance configuring 
the wired connection network settings, 
please contact your organization’s 
network administrator. 

http://www.gaumard.com/
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Dashboard™ Web 
Interface 
The Dashboard web interface allows 
facilitators to control the PRO+ remotely and 
playback the session footage using the virtual 
monitor PC’s web browser. The virtual 
monitors large display is ideal for reviewing 
video and debriefing the participants. 

To access the Dashboard interface, open the 
web browser on the Virtual Monitor PC type 
http://10.1.1.1 into the address bar and click 
Enter.  

 

The Virtual Monitor PC must be 
connected to the PRO+ Wi-Fi network to 
access the Dashboard interface. 

On the Dashboard logon screen, enter the 
default login information to continue. 

 

Username:  admin 

Password:  admin 

DASHBOARD CHANNELS 

The dashboard feature gives users remote 
access and control over several debriefing 
options and solutions. Click ETC to continue 

onto the PRO+ web interface screen. 

 

PRO+ DASHBOARD WEB 
INTERFACE 

The PRO+ web interface displays most of the 
controls and camera views available on the 
PRO+ screen. Users monitoring sessions 
through the web interface can rewind to earlier 
points in the session while the PRO+ system 
continues to record. In addition, facilitators can 
start and stop recordings, change camera 
views, enter flags, and edit metadata. 

 

ACCESSING SESSION 
RECORDINGS 

The session recordings are stored in the 
PRO+ computer. To access the recordings, 
click the “Library” button located near the top 
of the screen. 

Select the recording from the list and double 
click to play. Just like in the PRO+ computer, 
each recording file stores multiple camera 
views, audio, and time stamped events.  

Use the onscreen menus review the footage 
and debrief the participants. 

Dashboard Setup 

Click the Setup shortcut to access the 
Dashboard Setup screen. 
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Select the preferences tab to enter the 
administrator’s basic information. Navigate to 
the Quad View section to edit the main view 
video feeds. Lastly, configure which channel is 
displayed when the PIP view is enabled. 

 

EVENT TYPES & FLAG PRESETS 

The “event types” page displays the events 
objects used in the event log. Click the edit 
field to make changes to the event type 
properties. 

 

Flag presets are used to mark and indicate a 
point in time in which an event occurred. 
Customize the text on the flag fields and click 
save. 

 

RECORDING TIME OPTIONS 

Configure the recording time options to adjust 
the length of the back-buffer recording feature.  

 

Unlimited - Selecting this will use as much time 
as the memory will hold. This depends on the 
number of cameras and resolution.  

Limited - Selecting this will use the set back-
buffer time. 

DATE & TIME 

Set the correct time & date. Each session 
recording is time stamped and catalogued in 
the PRO+ library. 

 

NETWORK DRIVES 

The network drive list shows external drives 
and network details. To configure a network 
drive, click the “Add” button and then fill the 
configuration fields.  

 

For assistance configuring the network drive 
access, please contact the organization’s 
Information Technology department. 

SYSTEM LOG 

The system log displays all the activity that 
occurred on the PRO+ system. It displays the 
timestamp, product, category, message, 
username used, and IP address. 
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More about scenarios 
THINKING IN TERMS OF PALETTE ITEMS 

As described previously, palette items represent complete or partial groups of settings that have 
been stored as a single item. Applying partial states will hold constant all settings that are left 
unspecified. 

Not only does it take time to customize the palette, but a very large palette becomes difficult to 
navigate. So, it is desirable to minimize the number of Palette Items in each Profile. To accomplish 
this, an experienced facilitator tries to create items that are as generally applicable as possible and 
can therefore be applied to a wide range of scenarios. The key is to include only in your palette 
items the settings that are directly related to the physiological event represented by that palette 
item. 

SMART SCENARIOS 

After reading the Details, Palette, and Scenarios sections of this guide, it should be clear how to 
build a scenario. You may have already tried building your own or modifying some of the factory 
presets. The following four guidelines will refine your ability to build the best possible scenarios. 

1. How will the scenario begin? 

The first thing to consider is the initial condition of the patient. Create a Palette Item to describe this 
condition. Make sure that this first step in the scenario is a complete state. That is, indicate some 
selection for each available setting on the Details page. Remember that only the settings you 
specify will cause a change in CHLOE, and all other settings will remain constant. Therefore, by 
starting with a complete state, CHLOE’s condition will always be the same when the scenario 
starts, regardless of what she was doing previously. 

Likewise, the "transition duration" of the first step in the scenario should be zero, indicating that 
changes are applied immediately. 

There is one point that can cause confusion and warrants further explanation. It is an extension of 
the above discussion of partial states. The issue is best illustrated through the following example: 

Suppose that you are creating a Palette Item to start your scenario. In this case, you have decided 
that the patient will be apneic. The question is, "How should the lung sounds be set?" 

Most people's first inclination is to set the lung sounds to "none.” This is incorrect, despite apnea. 
Obviously, no lung sounds should be heard during apnea, but since you have already set 
respiratory rate to zero, none will be. (Sounds are synchronized to the breathing cycle.) 

What you are really setting here when you choose a lung sound is the condition of the lungs, given 
respiratory drive. That is, if the patient's respiratory rate were changed from zero, what sound 
would be heard? Assuming that the lungs themselves are normal in this scenario, you would 
choose "normal" for the lung sound setting. 

Then, as the scenario progresses, if the patient starts breathing, there will be no need to set the 
lung sound again. It will already be set. The same principle applies to the heart sound and other 
settings. 

2. Include notes to guide the facilitator during the simulation. 

It is common for scenario designers, especially those who act as facilitators, to neglect the 
importance of notes in the scenario. They think that they will remember the learning objectives, 
patient history, and other details at the time they are ready to conduct the simulation. They usually 
do not, especially when revisiting a scenario months after creating it. 

When you add "Wait" and "Wait Indefinitely" steps to a scenario, you have an opportunity to edit 
the item description. Use this description field to hold notes to the facilitator. Typically, scenario 
designers write notes in that space to indicate what the provider(s) or facilitator should be doing at 
that point. 

Further, when saving the scenario, you may edit the scenario description. This is the best place to 
put patient history and any other longer notes and instructions. 
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3. Assume that providers will do the right thing.  

Usually a scenario should be created with the assumption that the providers will perform correctly. 
As long as they do, the scenario can be allowed to continue. 

Naturally, preparation must be made for what might happen to CHLOE when providers deviate 
from expectations. The consequences of such deviations can sometimes be included in the 
scenario, punctuated by "Wait Indefinitely" items. In other cases, the simulation will require more 
direct control by the facilitator via either the Palette or Details page. 

4. Choose auto-response settings based on the scenario content and the objectives. 

As seen, auto-responses can be used to free the facilitators’ attention. They also enhance realism 
by presenting instant reactions to the care providers. On the other hand, sometimes it is not 
possible or desirable to determine the responses before the simulation begins. Different 
environments and applications call for different settings. 

Some teaching practices are best done with the auto-response settings in Prompt mode. 
Responses must be triggered by a vigilant facilitator. Though it is slower and requires more 
attention, the benefit of Prompt over other modes is that the simulation can be allowed to go in any 
direction, and it will be possible to choose the response on a case-by-case basis. 

Other learning exercises require a higher degree of automation. For such applications, most 
facilitators choose Auto mode for the auto-response settings. The key issue is standardized timing 
of symptom presentation. A consistent, repeatable simulation is essential for fair assessment of 
that care provider in relation to others and for the broader interpretation of results in the context of 
training validation studies. 

When in doubt, it is best to choose Prompt mode, in which the facilitator will be given direct control 
of the responses as events are detected.
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Troubleshooting 

Symptom Possible Cause Solution 

Simulator does not 
power on 

Communication is 
never established 

Data cable is not connected. 

USB communication Module 
is not connected. 

Verify connection of the Ethernet cable and USB module 
to the computer’s USB port. 

Wrong serial number entered 
in the options menu 

From the menu bar, enter the simulator’s serial number 
in the Setup> Options> Environment tab 

Power supply is 
disconnected 

Connect the power supply to the simulator and restart 
the GaumardUI software  

Artificial ventilations 
are not properly 
detected or not 
detected at all 

Respiratory rate is not set to 
zero 

Set the respiratory rate to zero 

Ventilations are not 
calibrated 

See “Calibration Wizard” section page 97. 

Chest does not rise 
with artificial 
ventilation (e.g. BVM) 

Simulator not running Turn the simulator on 

Respiratory rate is not set to 
zero 

Set the respiratory rate to zero 

Air is escaping between the 
mask and the simulator’s skin 

Maintain a tight seal between the BVM mask and the 
simulator 

Low chest rise (or no 
chest rise at all) while 
breathing  

Respiratory pattern is set to 
apnea 

Change the respiratory pattern to a healthy pattern 

Inspiratory percentage is set 
to a low value 

Set Respiration Rate to 13, and Inspiratory Time to 33% 

Chest compressions 
are not detected 

Heart rhythm is set to sinus Set the heart rhythm to a critical heart rhythm 

Compression sensor is not 
calibrated 

Calibrate the chest compressor using the GaumardUI 
calibration menu on page 97 

No left radial pulse Radial pulses disabled  Make sure to enable brachial pulse on “Details” tab page 

Blood pressure values are 
require calibration 

To calibrate, go to page 98 

Preprogrammed 
scenarios are not 
available 

 Load the “Quick Start Chloe” profile. 
To switch between profiles without exiting the software, 
Click File>Profile on the menu bar. 

The simulator’s 
audible features 
(heart, lung, 
Korotkoff, etc.) are 
low or cannot be 
heard at all 

Audio feature volume is set 
to mute or low 

Adjust the volume levels on the status panel 

Uterine assembly 
veins and arteries do 

The simulator is off Turn on the simulator and enable the bleeding functions 
using the manual GaumardUI controls 
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Symptom Possible Cause Solution 

not fill with blood Fluid reservoirs are empty Turn off the bleeding and refill the artery and vein 
reservoirs with fluid. Re-enable the bleeding and purge if 
necessary. 

Air is trapped in the uterine 
assembly vasculature 

Purge the trapped air in the assembly vein and arteries 
as shown on page 122. 

Palette item is not 
programmed to enable 
bleeding 

Verify that the current or previous palette item enables 
the arterial and venous bleed 

Ruptured ectopic is 
not hemorrhaging  

Bleeding is not enabled Enable the bleeding functions using the GaumardUI 
controls 

Ruptured ectopic pinch 
clamp is closed 

Open the ectopic pinch clamp and enable the bleeding 
functions using the GaumardUI controls 

Fluid reservoirs are empty Refill the fluid reservoirs with simulated blood 

Vagina does not bleed  Bleeding is not enabled Enable the bleeding functions using the GaumardUI 
controls 

The Uterine pinch clamp is 
closed 

Open the ectopic pinch clamp and enable the bleeding 
functions using the GaumardUI controls 

Streaming audio 
quality is poor or 
echo  

Headset is disconnected 

Headset connectors are 
connected to the wrong ports 

Headset is not recognized by 
GaumardUI 

Close GaumardUI and connect the MIC and Headphone 
jacks into the designated ports on the laptop. Restart the 
software. 

Headset is not set as default 
input device. 

Close the software and connect the MIC and 
Headphone jacks into the designated ports on the 
laptop. Then, set the headset as the default device on 
the laptop’s audio manager software. (tablet) 

Faulty headset Test using a headset know to work with other equipment 

 Microphone gain is set to 
high 

Lower the gain on the Streaming Voice Control window 

Vital signs are flat 
lined or not updating 

 

PC and virtual monitor are 
not connected to the wireless 
network 

Tablet only - Exit the GaumardUI software and the 
Gaumard Monitors software and connect to the 
GaumardNet network. Restart the Gaumard softwares. 

PRO+ only - Exit the GaumardUI software and the 
Gaumard Monitors software and connect to the PRO+ 
network. Restart the Gaumard softwares. 

GaumardUI is not 
broadcasting the vital signs 
information. Adapter is set to 
“loopback”. 

Tablet only - From the Gaumard menu bar, go to 
Monitors>Configuration. Set the adapter to “Wireless 
network connection”. Verify the controller IP and port 
number match the settings on the Gaumard monitor’s 
“Comm Setup” menu. 
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Symptom Possible Cause Solution 

PRO+ only - From the Gaumard menu bar, go to 
Monitors>Configuration. Set the adapter to “Local Area 
Connection”. Verify the controller IP and port number 
match the settings on the Gaumard monitor’s “Comm 
Setup” menu. 

USB communication module 
is not connected 

Connect the Communication module to the control 
computer and restart the software. 

Virtual monitor option is not 
activated 

On the menu bar, click Setup>Options> Environment tab 
and set the connection mode to FIXED, then enter the 
simulator’s serial number and save the settings. Return 
to the Options menu and select the “Add-ons” tab. 
Checkmark “Use virtual monitors” and enter the 
activation code. Finally, restart the software. 

 Sensors are off On the GaumardUI menu bar, go to Monitors> Sensors> 
and click “All on” 

Oximeter reading 
does not coincide 
with value set on the 
GaumardUI software 

Monitor sensor is placed on 
the wrong finger 

Place the sensor on the left index finger 

Oxygen saturation feature is 
not calibrated to work with 
the specific device currently 
in use 

Follow the instructions on page 98 to calibrate the 
simulator to work with the oxygen saturation monitor and 
sensor currently in use.  

 

 The simulator can only be calibrated to work with one 
oxygen saturation monitor and sensor at a time. 

Oxygen saturation monitors that detect carbon monoxide 
and/or methemoglobin are not supported. 

PRO+ overhead 
camera is not 
detected in the 
camera setup menu 

The camera’s power supply 
is not connected to a power 
outlet 

Connect the camera to the power supply and restart the 
PRO+ PC 

The PRO+ internal wireless 
antenna is off 

Set the PC’s wireless capability switch to the “On” 
position. 

The wireless network name 
has been changed 

On the PRO+ wireless network properties, change the 
wireless name back to the factory default. For more 
information, go to page 140. 

Camera is detected in 
the camera setup but 
there is no feed on the 
main window 

Main view distribution is not 
configured 

Click the Main view setup icon and select the active 
video and monitor feeds. 

Head camera is not 
detected on the 
camera setup menu 

Wireless transmitter is off 

 

Charge the wireless transmitter and turn on the device 

The Mobile SimLink software 
is not running on the wireless 
transmitter 

Launch the Mobile SimLink software and verify the IP 
destination matches the PRO+ webserver address 
10.1.1.1 
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Symptom Possible Cause Solution 

Camera is not connected to 
the wireless transmitter 

Connect the camera to the wireless transmitter and 
launch the Mobile SimLink software 

Wireless transmitter is out of 
range 

Move closer to the PRO+ system 

Events are not listed 
on the PRO+ event 
panel during the 
scenario 

RF Module is not connected Connect the RF module and restart the software 

PRO+ is not recording On the GaumardUI menu bar, go click File>New Session 
to start a new scenario 

Dashboard screen is 
unreachable or not 
found 

The PRO+ wireless antenna 
is off 

Set the PC’s wireless capability switch to ON. 

Virtual monitor PC is not 
connected to the PRO+ PC 

From the Virtual monitor PC, connect to the PRO+ 
network. 
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Wireless ad-hoc 
network  
(Chloe S2101 only) 
GaumardUI generates the vital signs information 
displayed on the virtual monitor PC. The information 
is transmitted through a wireless ad-hoc connection 
between the two computers in real time. 

The wireless settings are configured at the factory, so 
no additional configuration is required. Please 
reference the troubleshooting information on page 
147 to resolve common connectivity issue before 
attempting to reconfigure the network. 

Use the “Create an ad-hoc Wireless network” tool to 
configure the wireless ad-hoc link between the two 
computers. Then, configure the connection between 
GaumardUI and the Gaumard Monitors software. 

GAUMARDUI NETWORK 
CONFIGURATION 

Complete the next steps using the “Controller - Create 
Ad-Hoc Wireless Network” tool built in to GaumardUI 
software.  

1. From the menu bar, go to Help > “Create ad-hoc 
Wireless Network” 

The “Controller - Create Ad-hoc Wireless 
Network” window is displayed 

2. Select the “Wireless Network Adapter”. If the 
wireless adapter is not listed, first enable the 
adapter using the Windows

®
 network menu and 

then return to this window. 

 

3. Enter a wireless network name (case sensitive). 
Use the same wireless network name to 
configure the Gaumard Monitors PC. 
“GaumardNet” is the required name for 
Windows

®
 7 computers. 

 

4. Set the “Controller IP”.  

On each control PC and virtual monitor PC, enter 
the same values for the first three IP fields and a 
set unique value for the last field. The suggested 
address is for the Controller IP is 10.1.1.200 

 

5. Click “Apply Wireless Network Settings” to save 
the settings. 

6. Restart the computer. 

 

GAUMARD MONITORS NETWORK 
CONFIGURATION 

After the GaumardUI control computer is configured, 
complete the next steps using the “Create an ad-hoc 
network tool” included in Gaumard Monitors software.  

1. On the virtual monitor computer, click the 
Gaumard Monitors icon to start the vital signs 
software. 
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2. Click the V menu near the top left corner and 
select “Create Ad-Hoc Network”. 

 

The “Virtual Monitor - Create ad-hoc Wireless 
Network” window is displayed. 

3. Select “Wireless Network Adapter”. If the wireless 
adapter is not listed, first enable the adapter 
using the Windows

®
 network menu and then 

return to this window. 

 

4. Enter a wireless network name (case sensitive). 
Use the same name entered in the controller 
computer. “GaumardNet” is the required name for 
Windows

®
 7 computers.  

 

5. Set the “Monitor IP”.  

On each control PC and virtual monitor PC, enter 
the same values for the first three IP fields and a 
set unique value for the last field. The suggested 
address is for the Monitor IP is 10.1.1.220 

 

6. Click “Apply Wireless Network Settings” to save 
the settings. 

7. Restart the computer. 
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CONFIGURE THE VITAL SIGNS 
BROADCAST 

After the wireless ad-hoc link is established between 
both computers, complete next steps to configure the 
transmission of the vital signs information.  

1. Verify that both computers are connected to the 
GaumardNet network using Windows

®
 wireless 

connection menu. If the computers are not 
connected, select the “GaumardNet” network and 
click “Connect” manually. 

 

2. Start the GaumardUI control software. 

3. On the GaumardUI menu bar, click Monitors> 
Configuration. 

The “CHLOE Virtual Monitor Setup” window is 
displayed. 

4. Set the adapter to “Wireless network connection” 
and click “Connect” to begin transmitting the vital 
signs information. Write down the “controller IP” 
and “Port number”.  

5. Start the Gaumard Monitors software on the 
virtual monitor PC. 

6. Click the “V” menu near the top left corner, and 
then select “Comm Setup”. 

The “TCP Comm Setup” window is displayed. 

7. Enter the “Controller IP” and “Port number” 
displayed on the GaumardUI “Virtual Monitor 
Setup” window.  

8. Click “Connect” to accept the incoming 
connection.
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Consumable Items and Replacement Parts 
Contact Gaumard Scientific for a complete list of consumables and replacement parts and their prices. 
C=Consumables; R=Replacements; A=Accessories; U=Upgrades; M=Replace in Miami Factory ONLY 

Toll-free in the USA: (800) 882-6655 | Worldwide: 01 (305) 971-3790 | Fax: (305) 667-6085 

Item ID Name Type Description Notes 

S2100.001.R2 A/C Virtual Monitor R A/C Powered touchscreen “All-in-one” computer  

S2100.002 D/C Virtual Monitor R 
D/C Powered 12" Touch Screen Mobile Monitor 
with stylus 

 

S2100.023L.L Lower Left Arm C 
Lower left Osat arm with Osat index finger and 
microphone - re-veining 

Light skin tone 

S2100.023R.L Lower Right Arm C Lower right IV arm skin Light skin tone 

S2100.023L.M Lower Left Arm C 
Lower left Osat arm with Osat index finger and 
microphone - re-veining 

Medium  skin 
tone 

S2100.023R.M Lower Right Arm C Lower right IV arm skin 
Medium  skin 
tone 

S2100.023L.D Lower Left Arm C 
Lower left Osat arm with Osat index finger and 
microphone - re-veining 

Dark skin tone 

S2100.023R.D Lower Right Arm C Lower right IV arm skin Dark skin tone 

S2100.410 Replacement Veins R Replacement Antecubital Veins (latex)  

Not included in 
spare parts list 

 C Talcum powder  

S2100.081 Silicone Oil R Oil-based Silicone lubricant  

S2100.080 
Simulated Blood 
Concentrate 

C Simulated Blood Concentrate  

S2100.011 Battery Charger R Battery charger with label  

S2100.048 IV Filling Kit R Fluid dispensing syringe with filling tube  

S2100.056  R Blood reservoir cleaning kit  

S2100.060 Simulator Transport Case R Soft storage and transport case with wheels  

S2100.061 Simulator Transport Case A Hard storage and transport case with wheels  

S2100.207 Wired RF Module  R RJ45 Communications Module  

S2100.087  R Streaming voice headset  

S2100.013.D Abdominal Wall Insert C 
Multi-layer design representing the skin, 
subcutaneous, fascia, muscle, and peritoneum 

Dark skin tone 

S2100.013.L Abdominal Wall Insert C 
Multi-layer design representing the skin, 
subcutaneous, fascia, muscle, and peritoneum 

Light skin tone 

S2100.013.M Abdominal Wall Insert C 
Multi-layer design representing the skin, 
subcutaneous, fascia, muscle, and peritoneum 

Medium skin 
tone 

S2100.091  R Abdominal wall insert fasteners and nuts  
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Item ID Name Type Description Notes 

S2100.014.D Uterine Assembly 1 C 

Normal sized uterus including ruptured ectopic 
pregnancy; uterine bleeding; bladder; ovaries; 
fallopian tubes; perineum surface with integrated 
vagina; ovarian and uterine arteries; and round 
ligament, uterosacral ligament infundibulopelvic, 
and cardinal ligament; and peritoneum 

Medium skin 
tone 

S2100.014.L Uterine Assembly 1 C 

Normal sized uterus including ruptured ectopic 
pregnancy; uterine bleeding; bladder; ovaries; 
fallopian tubes; perineum surface with integrated 
vagina; ovarian and uterine arteries; and round 
ligament, uterosacral ligament infundibulopelvic, 
and cardinal ligament; and peritoneum 

Light skin tone 

S2100.014.M Uterine Assembly 1 C 

Normal sized uterus including ruptured ectopic 
pregnancy; uterine bleeding; bladder; ovaries; 
fallopian tubes; perineum surface with integrated 
vagina; ovarian and uterine arteries; and round 
ligament, uterosacral ligament infundibulopelvic, 
and cardinal ligament; and peritoneum 

Medium skin 
tone 

S2100.015.D Uterine Assembly 2 C 

Enlarged sized uterus including ruptured ectopic 
pregnancy; bladder; ovaries; patent  fallopian 
tubes; dermoid cyst; perineum surface with 
integrated vagina; ovarian and uterine arteries; 
and round ligament, uterosacral ligament 
infundibulopelvic, and cardinal ligament; and 
peritoneum 

Medium skin 
tone 

S2100.015.L Uterine Assembly 2 C 

Enlarged sized uterus including ruptured ectopic 
pregnancy; bladder; ovaries; patent  fallopian 
tubes; dermoid cyst; perineum surface with 
integrated vagina; ovarian and uterine arteries; 
and round ligament, uterosacral ligament 
infundibulopelvic, and cardinal ligament; and 
peritoneum 

Light skin tone 

S2100.015.M Uterine Assembly 2 C 

Enlarged sized uterus including ruptured ectopic 
pregnancy; bladder; ovaries; patent  fallopian 
tubes; dermoid cyst; perineum surface with 
integrated vagina; ovarian and uterine arteries; 
and round ligament, uterosacral ligament 
infundibulopelvic, and cardinal ligament; and 
peritoneum 

Medium skin 
tone 

S2100.016.D Uterine Assembly 3 C 

Enlarged sized uterus with embedded fibroids; 
endometrioma; simple cyst; bladder; ovaries; 
patent  fallopian tubes; perineum surface with 
integrated vagina; ovarian and uterine arteries; 
and round ligament, uterosacral ligament 
infundibulopelvic, and cardinal ligament; and 
peritoneum 

Medium skin 
tone 

S2100.016.L Uterine Assembly 3 C 

Enlarged sized uterus with embedded fibroids; 
endometrioma; simple cyst; bladder; ovaries; 
patent  fallopian tubes; perineum surface with 
integrated vagina; ovarian and uterine arteries; 
and round ligament, uterosacral ligament 
infundibulopelvic, and cardinal ligament; and 
peritoneum 

Light skin tone 



156 | Surgical | Surgical Chloe 

 

Item ID Name Type Description Notes 

S2100.016.M Uterine Assembly 3 C 

Enlarged sized uterus with embedded fibroids; 
endometrioma; simple cyst; bladder; ovaries; 
patent  fallopian tubes; perineum surface with 
integrated vagina; ovarian and uterine arteries; 
and round ligament, uterosacral ligament 
infundibulopelvic, and cardinal ligament; and 
peritoneum 

Medium skin 
tone 

S2100.017 Bowel Overlay       

S2100.018.D Laparoscopy Wall  C   Dark skin tone 

S2100.018.L Laparoscopy Wall  C   Light skin tone 

S2100.018.M Laparoscopy Wall  C   
Medium skin 
tone 

S2100.EXW 
Two Year Extended 
Warranty 

A Extended warranty for years Two AND Three  

S2100.INST In-Service Training A Day of in-service training and installation  
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Warranty 
EXCLUSIVE ONE-YEAR LIMITED WARRANTY 

Gaumard warrants that if the accompanying Gaumard product proves to be defective in material or workmanship 
within one year from the date on which the product is shipped from Gaumard to the customer, Gaumard will, at 
Gaumard’s option, repair or replace the Gaumard product. 

This limited warranty covers all defects in material and workmanship in the Gaumard product, except: 

1. Damage resulting from accident, misuse, abuse, neglect, or unintended use of the Gaumard product; 

2. Damage resulting from failure to properly maintain the Gaumard product in accordance with Gaumard 
product instructions, including failure to property clean the Gaumard product; and 

3. Damage resulting from a repair or attempted repair of the Gaumard product by anyone other than Gaumard 
or a Gaumard representative. 

This one-year limited warranty is the sole and exclusive warranty provided by Gaumard for the 
accompanying Gaumard product, and Gaumard hereby explicitly disclaims the implied warranties of 
merchantability, satisfactory quality, and fitness for a particular purpose. Except for the limited obligations 

specifically set forth in this one-year limited warranty, Gaumard will not be liable for any direct, indirect, special, 
incidental, or consequential damages, whether based on contract, tort, or any other legal theory regardless of 
whether Gaumard has been advised of the possibilities of such damages. Some jurisdictions do not allow disclaimers 
of implied warranties or the exclusion or limitation of consequential damages, so the above disclaimers and 
exclusions may not apply and the first purchaser may have other legal rights. 

This limited warranty applies only to the first purchaser of the product and is not transferable. Any 

subsequent purchasers or users of the product acquire the product “as is” and this limited warranty does not apply. 

This limited warranty applies only to the products manufactured and produced by Gaumard. This limited 

warranty does not apply to any products provided along with the Gaumard product that are manufactured by third-
parties. For example, third-party products such as computers (desktop, laptop, tablet, or handheld) and monitors 
(standard or touch-screen) are not covered by this limited warranty. Gaumard does not provide any warranty, express 
or implied, with respect to any third-party products. Defects in third-party products are covered exclusively by the 
warranty, if any, provided by the third-party. 

Any waiver or amendment of this warranty must be in writing and signed by an officer of Gaumard. 

In the event of a perceived defect in material or workmanship of the Gaumard product, the first purchaser must: 

1. Contact Gaumard and request authorization to return the Gaumard product. Do NOT return the Gaumard 
product to Gaumard without prior authorization. 

2. Upon receiving authorization from Gaumard, send the Gaumard product along with copies of (1) the original 
bill of sale or receipt and (2) this limited warranty document to Gaumard at 14700 SW 136 Street, Miami, FL, 
33196-5691 USA. 

3. If the necessary repairs to the Gaumard product are covered by this limited warranty, then the first 
purchaser will pay only the incidental expenses associated with the repair, including any shipping, handling, 
and related costs for sending the product to Gaumard and for sending the product back to the first 
purchaser. However, if the repairs are not covered by this limited warranty, then the first purchaser will be 
liable for all repair costs in addition to costs of shipping and handling. 

EXTENDED WARRANTY 

In addition to the standard one year of coverage, the following support plans are available: 

 Two-Year Extension (covers second and third years) 

 Call for pricing (USA only)
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Contact Us 
On the web  

www.Gaumard.com 

Technical Support  

support@gaumard.com 

Sales and Customer Service 

sales@gaumard.com 

Phone: 

Toll-free in the USA: (800) 882-6655 

Worldwide: 01 (305) 971-3790 

Fax: (305) 667-6085 

Before contacting Tech Support you must: 

 Have the simulator’s Serial Number 1.
(located in the left leg under the IM site) 

 Be next to the simulator if 2.
troubleshooting is needed 

Gaumard Scientific  

14700 SW 136 Street 

Miami, FL 33196-5691 USA 

Office hours: Monday-Friday, 8:30am - 
4:30pm EST (GMT-5, -4 Summer Time)  

Always dispose of this product and its 
components in compliance with local laws 
and regulations. 

 

The SURGICAL CHLOE simulation system 
is protected by US patens; other Patents 
Pending.  

Gaumard®, CHLOE ®, HAL
®
 are trademarks 

of Gaumard Scientific Company, Inc. 

© Gaumard Scientific Company, 2013. Made 
in U.S.A. All rights reserved. 

 

http://www.gaumard.com/
mailto:support@gaumard.com
mailto:sales@gaumard.com
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